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S! Quick News (Japanese)

Add news headlines, weather forecasts, etc. via S! Quick

News List to scroll across Standby Window.

® Registering or viewing S! Quick News incurs transmission fees. No fees
apply for viewing ticker information. For more information, visit
SOFTBANK MOBILE Corp. Website (http://www.softbank.jp).

I Registering S! Quick News Items

® Register one Quick news, up to four General news and one Special
news.

Main Menu p Entertainment »> S! Quick News
p S! Quick News List

Add News - YES

Yahoo! Keitai connects and contents list appears.

Select an item
Follow onscreen instructions.

\H

I Opening New Information

Viewing New Information in Standby
When new information is received, @ appears in Standby.

1 In‘Standby, (B) - 639 to move pointer = Select ticker

2 (@)[Select]

Content list appears.

3 Select information
Details appear.

P eececcccccccccccccccccoe

(ETITD @Turn Back Light Off after All S! Quick News Viewed (C3P.18-6)
@Show Only Unread Items in Standby @Change Marquee Speed
@Hide S! Quick News @Show Image Data (%P.18-16)
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Opening S! Quick News List

Icons

£
B, Unread General news

-.|E
=2

ﬁ Unread Quick news

"‘—‘}1 Read Quick news ¥ Read General news

:@J Auto Refresh disabled Unread Special news

?7'", Read Special news

Main Menu P Entertainment »> S! Quick News
} p> S! Quick News List

1 Selectan item
Content list appears.

2 Selectinformation
Detailed information appears.

3 To connect to the Network, select a title = YES

I Update Manually
> In Step1, ()[Menu] = Update or All Update - YES

M View Summary
> In Step 1, highlight information = (37)[Menu] = Summary Display

\H

I Delete Registered Items
> In Step 1, (highlight information =) (&)[Menu] = Delete or
All Delete - YES (= For All Delete, enter Phone Password)

® Alternatively, Main Menu p> Entertainment p> S! Quick News
p> Settings p> Del S! Quick News List p> YES to delete all
information

P eceeccccccccccccccccccoe

(T @Automatically Update S! Quick News List
@Delete S! Quick News Information (C%P.18-16)
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S! Information Channel/Weather
(Japanese)

Subscribe to content and periodically receive updates. Set
Weather Indicator to appear on Standby.
® Transmission fees apply for updates.

I Registering/Canceling

Main Menu p> Entertainment »> S! Info Ch./Weather
1 Register/Cancel - YES

941P connects to the Network.
Follow onscreen instructions.

I Using S! Information Channel
@ Up to seven updates are saved.

Viewing New Information
When information arrives, jeg and Event

Indicator appear in Standby.

1 InStandby, (B) - 34 to move

pointer = Select Event Indicator

2 (@][Select]

Follow onscreen instructions.
@ Option Menu Items (C%P.7-8)

Il Manually Retrieve Information
Select Event Indicator "Failed to download"
® Alternatively, Main Menu p> Entertainment
p S! Info Ch./Weather p> Get Latest Contents > YES

I Delete Information
> Main Menu p> Entertainment p> S! Info Ch./Weather
> Highlight What's New? > (xJ[Menu] > Delete b YES

® Alternatively, Main Menu p> Entertainment
p S!'Info Ch./Weather p> What's New? to retrieve information
@ |f there is unread information in both S! Quick News and S! Information

Channel, ieg does not appear. Only Event Indicator appears.

Viewing Previously Received Information

Main Menu > Entertainment »> S! Info Ch./Weather

History — Select a date
‘AE for unread news and w for read news appear.

I Delete History

>Main Menu p> Entertainment p> S! Info Ch./Weather p> History
P (Highlight a History) > (3)[Menu] p> Delete or Delete all - YES
( > For Delete all, enter Phone Password)
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I Using Weather Indicator

Weather Indicator for current forecast area appears in
Standby.

Viewing New Information

Event Indicator and Weather Indicator appear for weather
updates.

1 InStandby, (B) - 634 to move pointer — Select Event
Indicator or Weather Indicator

2 (@][Select]

Information appears.
Follow onscreen instructions.
® Option Menu ltems (C%P.7-8)

Weather Indicator

Indicators are updated periodically.

Example: <@ Clear, @4 [> 7 Rain later thunderstorm,

sy Cloudy with occasional snow, etc.

@ See Weather Indicator List (C3P.19-24) for a complete list of indicators.

B Manually Update Weather Indicator

Select Event Indicator "Failed to download"

® Alternatively, Main Menu p> Entertainment
p S! Info Ch./Weather p> Weather Indicator p> Manual Update
> YES

M Hide Event Indicator
> Main Menu p> Entertainment p> S! Info Ch./Weather
p Weather Indicator B> Missed Event Settings p> OFF

® Alternatively, view forecast details from Main Menu
p Entertainment p> S! Info Ch./Weather p> Weather Indicator
» Weather

Hiding Weather Indicator

Main Menu p> Entertainment »> S! Info Ch./Weather
»> Weather Indicator p> Display Settings

OFF
® \When Display Settings is set to OFF, update is also deactivated.
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I Option Menu Items

While viewing a content, press (x7)[Menu] for these options.

\H

E-Books (Japanese)

Use BookSurfing® to acquire/view e-books, comics, photo
books, etc. or e-Book Viewer to view XMDF files on 941P.

Item Operation/Description

Forward GO to next page

® BookSurfing® and e-Book Viewer are S! Appli.
@ Download Content Keys (%P.9-5) to read CCF/XMDF files.

Text Copy Copy page text

® Some copy protected files have extensions different from the ones below.

Select File  View, play or save file to Data Folder (From Step 2 in

Downloading Image/Sound Files: C%P.14-11) A.ppI;catlon Bilelksmat

Jump in this  Jump to top/end of page BookSurfing CCF (cc)
page e-Book Viewer XMDF (.zbf, .zbk, .zbs)
Yahoo! Keitai View top menu @ Some PC content may not be viewable via e-Book Viewer.

i h h ize* or ch i h . .
Fopt S_lze. C Iange character size* or character conversion method Main Menu D> Entertainment
Exit viewing Exit content
this

* Linked with Font Size setting in Internet option menu.

1 BookSurfing or e-Book Viewer
® See application Help menu for usage information.

® Launch BookSurfing®/e-Book Viewer via S! Appli, or select a file from
Books in Data Folder.




Overview

Saving Music
Downloading Chaku-Uta Full®
Saving Music Files by Using
Transferring WMA Files

Using Music Player ..
Playback Window Indicators ..
Playing Music
Playback Window Operat
Functions while Playing File
Chaku-Uta Full®/WMA List..

Using Play List
Play List
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Overview
Play music saved on 941P/microSD Card.
® Play List: £%P.8-10

Notes

@ Files may not play due to file support issues or microSD Card status, etc.

® When battery is low, Music Player cannot play files.

® When battery is low during playback, confirmation appears.

® Playback pauses for incoming calls or Alarm. Playback resumes after calls
are received or Alarm sounds.

Music lllumination

@ Notification Light illuminates when playback starts. When playback
starts during charging, Music lllumination lights before Charging
Indicator.

® To turn off light, set Music to OFF in Notification Light setting
(C%P.18-10).

Saving Music

Save Music to play on Music Player.

Open site link to download and save songs

Download ~  -otoiiceoooeooiiTio
CI(::I’(TJ-Olfta Full® Supported file format: SMC, MPEG-4
(C¥P8-3) (MPEG-4 AAC, MPEG-4 AAC+ (HE-AAC),

Enhanced aacPlus)

Save music CD songs via PC to microSD Card in
AAC format

Supported file formats: MPEG-2 AAC,
MPEG-2 AAC+SBR

Save Music via
SD Audio (%P.8-3)

Save Windows Media® Audio (WMA) files in PC
to microSD Card via Windows Media® Player

Save WMA files
(C%P.8-4)

® Use earphone when listening to music.

JPeececcccccccccccccccccoe
@Use Bluetooth® Device for Wireless Playback (c%P.10-10)

Supported file formats: WMA

® Some files may not play even if format is supported.
® Copy protected files do not play after license expiry (Content Key: £%P.9-5).

Copy Protected Files

Copy protected files may not play, be saved or forwarded.

To play a copy protected file, obtain Content Key (%P.9-5).
Confirm file expiry date or usage limitations (Music info: 5P.8-8).



Saving Music Files on PCs
When saving music files for use with 941P, observe the following
guidelines:
® Copyrighted Works
- Do not infringe on third party/intellectual property rights.
- Music files are limited to private use.
@ Obtain software to convert file format.
- Refer to websites providing software.
- Performance of some software types is not guaranteed.

I Downloading Chaku-Uta Full®

Access websites directly from Music Player to download
Chaku-Uta Full® files.

® View details (price, expiry date, etc.) on source website.

Main Menu p Music Player p> Data Manager »> Main Folder
» Download Music

YES

941P connects to the Network and Download site appears.
@ Follow onscreen instructions to download files.

\H

I Saving Music Files by Using SD Audio

Note
@ Saving music files requires following:
- 941P
- microSD Card (commercial item)
- USB cable (not included)
- PC (Windows® XP, Windows Vista®)
- Software for PC (commercial item)
Panasonic brand "SD-Jukebox" is recommended. Purchase
SD-Jukebox from website below:
http://club.panasonic.jp/mall/sense/ (Japanese only)
- Music CD to save

Main Menu p- Settings »> Connectivity » USB Mode
» microSD Mode

1 Connect 941P to a PC via USB cable

Activate SD-Jukebox on PC

® Alternatively, follow these steps to access Download site:
Main Menu p- Data Folder p> Music »> Main Folder
» Download Music p> YES

Save music files to micro SD Card

® See SD-Jukebox manual for usage information.
® After saving, release USB cable from 941P.

2
3 Set a music CD on PC
4
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I Transferring WMA Files

Transfer WMA files from PC to microSD Card via Windows

Media® Player. Up to 600 files can be saved per microSD

Card.

® Use PC with Windows Media® Player installed.

® When using Windows Media® Player 10 (10.00.00.3802 or later)/11 on
Windows® XP, use Windows® XP Service Pack 2 or later.

® When using Windows Vista®, use Windows Media® Player 11.

® Insert microSD Card into 941P before preparing USB cable (Transferring
Data via USB Cable: c%P.10-12)

Main Menu p> Settings P> Connectivity » USB Mode
» MTP Mode

1 Connect 941P to a PC via USB cable

Follow Windows Media® Player operations to transfer WMA files from
PC to microSD Card.
® Refer to Windows Media® Player Help for operations.

® Terminate all software applications before disconnecting USB cable.

\H

_Note |

® Do not remove microSD Card while transferring files to microSD Card.
Files may be damaged.

® \WMA files overwrite existing files with same name in handset when
copied from PC. To check file names, refer to Windows Media® Player
Help.

® 941P may not recognize WMA files saved to a microSD on a different
handset. Handset may not recognize WMA files from PCs if USB Mode
is set to MTP Mode. Delete WMAudio and WMSystem folders in My
[tems (MY FOLDER) on microSD, or format microSD Card (C%P.9-18) via
PC. Formatting microSD deletes all saved files.

® To play WMA files on handset, save files to WMFile (£%P.9-20) on

microSD Card and play the files from PC Movies folder in Data Folder.




Using Music Player

I Playback Window Indicators

Now Playing

Item

Description

File Number/Total Number

Title

Artist

Status

Elapsed Time/Total Time

@00 0e

Play Mode Indicators

Play only one Repeat one
Repeat all Random
EZ] Random play&repeat

DEMO

Equalizer Setting

Normal H.BASS1
H.BASS2 Train

@ | Stereo/Monaural Stereo Monaural
@ Listening Setting Surround-sound
Natur 1
Natur 2
®| Remaster Setting ON | —
@ | Bluetooth® Device —
Connected
®| Volume —
®| Lyric —
®| URL —
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I Playing Music

® Alternatively, follow these steps to play back music files:

1 Press and hold Main Mepu } Music Player p> Player . .
) [IEALI Tracks ] ® mp4/3gp files in Ring Songs&Tones folder can also be played in Music
Player Menu window appears. BlSArtist Plaver
® Last playback window appears. g%é‘;ﬂ-BD ° Why . ' . .
’ . en playing back files with handset closed, missed calls or new
To open Player menu: twice. minkaid messages cannot be checked by [1] even if Info Notice Setting
Player Menu Window (CP.18-7) is ON.
2 Select a category (See below) Changing Play Mode
Item Operation/Description 1 Press and hold
All Tracks Select files from 941P & microSD Card Player Menu window appears.
Artist Select files from Artist folder ® Last playback window appears. To open Player menu: twice.
Album Select files from Album folder 2 [Menu] - Play mode setting
Genre Select files from Genre folder
Play List Select group of files saved to Play List 3 Select an item (See below)
® >k appears for currently/previously played Play List. - Operation/Description
3 Select a file Normal Play all files in selected category/Play List
Selected file plays. Play only one Play selected file
® >k appears for currently/previously played file. Repeat one  Repeat selected file
® Playback Window Operations: £%P.8-7 Repeatall  Repeat all files in selected category/Play List
® To end playback, (=)[ HCH] Random Play selected category/Play List files randomly
Random Repeat selected category/Play List files randomly
play&repeat




Using Other Functions while Listening to Music
(Play Background)

Use Phone Book, Messaging, Internet, etc. while listening to music.
1 While playing file, (&) [BGM]
2 Toend, in Standoy = End player

® Some functions cannot operate simultaneously.
@ \/olume or play mode change is not available during Play Background.

Playing Chaku-Uta Full®/WMA Files as Demo

Main Menu P Music Player p> Data Manager

1 Select an item (See below)

Item Operation/Description
Main Folder  View Chaku-Uta Full® list
> Select a folder
@ To view file list in handset/microSD Card:
(@)[Phone/microSD]
WMA View WMA list
® ()[Change] to toggle display view in Chaku-Uta Full® and WMA
list.

2 Select a Chaku-Uta Full® or WMA file

Demonstration playback starts.

\H

I Playback Window Operations

Adjust Volume

@ or @

Play Previous*

) or press and hold [4

® \When playback time is over
three seconds, previous file
plays from beginning.

Play Next* (o9 or press and hold [1
Rewind Press and hold (0)
Forward Press and hold (o)
Pause/Resume O u I » |
Stop (=[]

View Next Jacket/Lyric

View Previous Jacket/Lyric

Switch Jacket/Lyric Display
‘S,vv;l;tdc:v\l:jayllst/Playback @ )List/Player]
Play Background* (O)[BGM]

Switch Remaster (% P.8-8) D)

Switch Listening (> P.8-8)

Switch Equalizer (% P.8-8)

* Not available for playback as a demo

1ake|d d1sn | o0
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I Functions while Playing Files

M Set Sound Effect
> While playing file, (x7)[Menu] = Sound effect = Select an item
(See below)

I Functions Available in Playback Window
> While playing file, (z)[Menu] = Select an item (See below)

Item Operation/Description

Player menu  Show Player menu

Item Operation/Description
Remaster Complement sound from earphone or Bluetooth® device
to bring close to original sound
> ON or OFF
Listening Add listening effect to sound from earphone or Bluetooth®
device

> Select an item
- Surround-sound’: Reproduce natural and
stereophonic sound
- Natur 1 or Natur 2: Complement sound specific to
earphone to reproduce natural sound
- OFF: Turn off Listening setting

Play mode  Change play mode (%P.8-6)
setting

Sound effect (%Left)

Music info Show song title, artist and playback time

Connectto  Opensite link
Website > YES

Display Image Show jacket

Display lyric ~ Show lyric

Previous image/ Show previous jacket or lyric
Previous lyric

Next image/  Show next jacket or lyric
Next lyric

Equalizer Change quality of sound from earphone or Bluetooth®
device
> Select an item
- Normal: Reproduce normal sound
- H. BASS1: Enhance low-pitched sound
- H. BASS2: Enhance low-pitched sound even more
- Train: Minimize sound leakage




| Chaku-Uta Full®/WMA List

(From Jp Main Menu b Music Player p- Data Manager
M Confirm Memory Status

Item Operation/Description

Move to Move a Chaku-Uta Full® to microSD Card
microSD '

Add folder ' > Enter folder name

Multiple- Select multiple Chaku-Uta Full® files
> (2)[Menu] -+ Memory Status choics* > Check Cf?aku—Uta Full® files = (x7)[Menu] - Delete,
M Functions Available in Chaku-Uta Full® Folder List Move or Send Ir data - Operate selected item
> Main Folder — Highlight a folder - ()[Menu] = Select an item Connectto  Opensite link
(See below) Website ' >YES
Item Operation/Description Display image Show jacket
Add folder > Enter folder name Memory Memory status/total number of files appears
Edit folder > Enter folder name Status
TETTE DEL all Delete all WMA licenses
Delete folder > Enter Phone Password - YES REEEE 2_ > Enter Phone Password - YES
Memory > Confirm memory status/total files BECIENEN > YES
Status Delete all Delete all files in folder
> Enter Phone Password = YES
M Functions Available in Chaku-Uta Full®/WMA File List Attach to Send a file via S! Mail (C3From Step 2 on P.13-4)
> Main Folder or WMA (= Select a folder) = Highlight a file = S! Mail !
(x)[Menu] — Select an item (See below) Send Ir data ' (C%P.10-3)
Item Operation/Description IC (P.10-5)

Set as ring Set Chaku-Uta Full® as ringtone
tone (Fullsong > Fullsong ring tone — Select an item
ring tone) '

transmission '

Take contents (C%P.9-5)
key '

Setasring  Seta segment of Chaku-Uta Full® as ringtone
tone (Point > Point ring tone — Select a segment = Select an
ring tone) ' item
® To confirm segment: (=)[Play]
Music info  Show song title, artist and playback time
Move ' > Select a storage

! Chaku-Uta Full® files only
2 WMA files only

1ake|d d1sn | o0
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I Using Play List

Use Play List to organize Data Folder music files.
Select Music folder files to create Play List links to each file
in its original folder.

Creating New Play Lists

@ Save up to 30 Play Lists with up to 100 songs per list.
® Music files saved on microSD Card are also savable.

1 Press and hold

Player menu appears.
® Last playback window appears. To open Player menu: twice

D Play List » (x7[Menu] » L2t List___
Create play list = Select a Elkeitai—001
category and show file list & Check TBD
files to save to Play List =

(&)[Finish]

3 Entera Play List name

Play List Window

® Create WMA Play Lists (using Windows Media® Player) or SD Audio Play
Lists (using SD-Juke Box) on PC. Maximum number of Play Lists to
create and songs to save is as follows:
WMA Play Lists: 100 Play Lists; 250 songs per list
SD Audio Play Lists: 99 Play Lists; 99 songs per list

Playing Songs from Play List
1 Press and hold

Player menu appears.
® Last playback window appears. To open Player menu: twice

9 Play List - Select a Play List
I]l09 06-06-001

® To play back selected Play List from the  [E2/09-06-06-002

beginning: (=)[Play] E]I_TB.

3 Select a file
Selected file plays back.

Play List Contents
Window

® mp4/3gp files in Ring Songs&Tones folder can also be added to Play
List.




I Play List

Press and hold > Play List

M Functions Available in Play List Window
> (Highlight a Play List) (7)[Menu] = Select an item (See below)

Item Operation/Description
Add Add files to Play List
> Select a category, and show contents window —
Check files to add (=)[Finish]
DEL from Delete files from Play List
play list > Select an item — Operate selected item

Item Operation/Description

Player menu  Open Player menu

Order to play

> Select a file from Play List to change playing order =
@) to change order - (@)[Select]
® Repeat steps above to change order = (=)[Set]

Play mode  Change play mode (Z3P.8-6)
setting

Create Create a new Play List (C%P.8-10)
play list

Add to
play list

Add files to another Play List
> Add one or Add some (- For Add some, check
files = (=[Finish]) = Select a Play List

Copy play list Copy Play List
> Enter a Play List name

Display image Show jacket

Edit pl. list  Edit Play List name
name > Edit Play List name
Add Add files to Play List
> Select a category, and open a Play List = Check files
to add = (=)[Finish]
Delete > Select an item —= Operate selected item
play list

M Functions Available in Play List Contents Window
> Select a Play List = (Highlight a file) & (3)[Menu] - Select an item
(See below)

Item Operation/Description

Player menu  Open Player menu

Play mode  Change play mode (Z3P.8-6)
setting
Music info  Show song title, artist and playback time

1ake|d d1sn | o0
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Data Folder
Data Folder Structure
Opening Files
Viewing & Playing Files.
File Display/Playback Functio
Options
Using/Editing Still Images ..
Editing Still Images....
Creating Animations.
Saving Still Images to Phone Book
Managing Folders/Files ...
Managing Folde
Using Play List
microSD Card
microSD Card Installatio
Format microSD Card....
Viewing microSD Card Files ..
Handset Data Backup
PC File Transfers
microSD Card Functions




Data Folder

Save, play and manage files downloaded from Internet, etc.
® Save still images/videos captured by Camera, downloaded data or data copied/moved from SoftBank handset to microSD Card.

I Data Folder Structure

Music Search

Initial Folder

Downloaded Chaku-Uta Full®

WMA 3

WMA Files transferred from PC

Folder Function/Saved Data File Format '
Pictures 2 Download Pictures Connect to download site JPEG, GIF (.gif including
Main Folder Downloaded still images, etc. Interlaced GIF),
Camera Still images captured by Camera, etc. GIF Pictogram Package File
My Download My Pict. Connect to download site (.gpk), SWF (.swf Flash
n Pictograms | BRICAD Downloaded pictograms, etc. Animation),
BB, SEA, etc, Preinstalled pictograms PNG (.png including Interlaced
§ Mail Art Mail Art (download) Connect to download site PNG)
z Pre-installed Preinstalled still images
=3 Original Animation Display still images continuously
3 Ring DL Ring Songs&Tones Connect to download site SMF, SP-MIDI, AMR, SMAF
] Songs&Tones * | Main Folder Downloaded ring songs/tones, etc. and MPEG-4 formatted files
o Pre-installed Preinstalled ring songs/tones (.mid, .midi, .amr, .mmf, .3gp,
Voice Announce Data recorded by Voice Announce .mp4)
Play List Play back Play List
S! Appli ? Download S! Appli Connect to download site -
Widget ? Download Widget Connect to download site WGT (wgt), SWGT (.swgt)
Music Main Folder 2| Download Music Connect to download site MP4, SMC, WMA (.3gp, .mp4,

.Smc, .wma)

9-2
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Documents ?

Folder Function/Saved Data File Format '
Videos * Download Videos Connect to download site MP4 (including .mp4, .3gp,
Main Folder Downloaded video files, etc. SDV), ASF (.asf)
Camera Video files recorded by Camera
Pre-installed Preinstalled video files
Play List Play back Play List
Position Memory Play back video files from saved resume position
PC Movies microSD 3 PC movies saved using PC WMA (.wma), WMV (.wmv),
Position Memory Play back PC movies from saved resume position ASF (.asf)
Play History Playback records of PC movies
v Image Still images recorded by Digital TV JPEG (.jpg)
Video 3 Copy-protected video files (One-Seg compatible) TOD (.tod), MOI (.moi),
Position Memory Play back video files from saved resume position MAI (.mai), PGI (.pgi)
Lifestyle-Appli| Download Connect to download site (Osaifu-Keitai®: £%P.16-2) -
Books 2 Download Books Connect to download site CCF (.ccf), XMDF (.zbf, .zbk,
.zhs)
Customized | Customized Screen Connect to download site CUSR (.xcsf)
Screen 2 Familiar Usability UIE (.uie)
Templates Download Templates Connect to download site -
Font Download Font Connect to download site MTF (.mtf)
Main Folder Downloaded fonts
Pre-installed Pre-installed fonts
Other Main Folder Incompatible files attached to mail ¢ -

! Some copy protected files have extensions different from above.
2 When microSD Card is installed, press (&)[microSD] in Folder list to view data saved in microSD Card.

3 Available only when microSD Card is installed.

4 Some attachment files cannot be saved in Other Documents.
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Using Copy Protected Files

Playing/forwarding/saving may be restricted and Content

Key (%P.9-5) may be required for usage.

See file information to confirm restrictions such as expiry

term or usage limitation (Respective file information in

"Options": %P.9-7).

® % or @ (Silver) appears for copy protected files requiring Content Keys.
files are inaccessible.

® Files downloaded on 941P cannot be used on PCs.

® Network setting may be required for usage.

@ File usage may require insertion of USIM Card in use at time of
download.

® 941P holds up to 1000 Content Keys. Multiple Keys may be required to
use a file. Expired Keys are deleted automatically.

@ Interrupted playback (by incoming calls or Alarm) of copy protected WMA
files with limited usage in Data Folder is also counted as one usage.

Opening Files
IViewing & Playing Files
Main Menu p> Data Folder

1 Select a folder

folder and microSD Card folder.

2 Select a folder = Select a file

File appears/plays.

® To toggle file list view: (ca)[Change]

e Pictures |
@iDownload Pictures
@ In Folder List, press (&) to toggle handset ._Mann Folder

PCamefa

1PNy PlciSyi'ams
EPMail Art
[@P=Pre-instal led

Pictures Folder

l&x  Camera |

HCJZOOQOGOM 0250004
wiDZ=@9

Still Image List
Window

When Shortcut to a Download Site is Selected
Handset connects to a download site on Internet.

I Operations while Playing Back Ring Songs&Tones

to S! Mail

Stop (o)Istop]
Volume B/
Attach files (during playback) S = )
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I Videos/PC Movies Playback Operation
® Some operations are not available depending on files.

Adjust Volume B or WM

©
® Starts from beginning when playback time is
over three seconds.

Play Previous

Play Next (o9

Rewind ' Press and hold (o)

Forward ' Press and hold (o)

Select Position 2 (29 repeatedly

Content Key

If Content Key is expired, a message appears when the file

is opened. To obtain a new Key, select YES. 941P connects to

Content Key site.

® Copy Protected Files: c%P.9-4

° T;l or & (Silver) appears for files requiring Content Keys. (i files are
inaccessible. B4 appears on images in Thumbnail view of expired files
(Original icon appears for Books folder.).

® Alternatively, obtain Content Key as follows: Highlight a file =
(¥)[Menu] - Take contents key

® Depending on contents, some Content Keys may not be obtained from
websites even when warning for expired contents appears.

® When 1000 Content Keys have been saved, a message appears. Delete
old Keys; otherwise downloads may fail (Connection fees apply).

Change Speed @[ EN/ =N /)
Mute/Resume )| HEE /T |
Pause/Resume (o) I/ )

Play Frame by While pausing, (=)[Frame]
Frame ' ® Play back frame by frame
Switch Portrait/

Landscape View ()

(Full Screen)

Remaster ([¥P8-8) | (D

Listening (C3P.8-8)

Equalizer (C%P.8-8)

Videos only
PC Movies only

~

PP eececcccccccccccccccccoe
@File Display/Playback Functions (%P.9-6)
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I File Display/Playback Functions

M Enlarge Still Images
> Main Menu p> Data Folder p> Pictures p> Select a folder p> Select a
file » (x[Menu] b Display size p> Fit in display

I Play Back from a Resume Position

Resume playback (videos/PC Movies) from a saved position.

>Main Menu p- Data Folder P> Videos or PC Movies
»> Position Memory b Select an item

@ Save a resume position: C¥Right

® Marker to resume is a resume position automatically saved when a
call comes in, alarm goes off, battery runs low, or playback is terminated.

Item

Operation/Description

Sound effect

Remaster, Listening or Equalizer ((%7P.8-8)

(Ringtones) '

Contents Show title, file name, etc.
info ?
Position Save resume position
memory > Select a resume position
@ To play back from a saved position: L% Left
Attach to Send file via S! Mail
S! Mail ' (5 From Step 2 on P.13-4)
Register Set as ringtone

> Ringtones — Select a type
® Sk appears for item set as ringtone.

Register Save a file as Standby Display or Start-up Window
M Functions Available in Video/PC Movie Playback Window (Stand-by > Select an item = YES
@ Some operations are not available depending on files. Display/Start-up
> While playback is paused, (x7)[Menu] = Select an item (See below) Window) '
Item Operation/Description Video info !  Show title, file name, etc.
Normal play ' Play at normal speed Send Ir data ' Send file via Infrared (£%P.10-3)
Slow | Play at slow speed lC o Send file via IC transmission (C%P.10-5)
— - ransmission
8”';5'()(;1:(!‘” Play 1.25 times faster than normal _Add fhortcut Create a shortcut (P.1-22)
- icon
3;2::;2)() ¢ Play at double speed Description 2 Show file informa.tion o
Fast? Forward > The words view or Description view
. - Copy URL?  Copy URL
Rewind 2 Rewind i i i i
Display size  Select a display size
Stop Return to Videos/PC Movies List window > Actual size or Fit in display
Position to  Start playback from specified point Change to  Switch to Landscape View. Full screen playback starts.
play > (99 to highlight a play point = (e)[Set] full ! ® To toggle views: ()
Connectto  Open site link ' Video files only
Website ' >YES

2 PC movies only

PR
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I Options Item Operation/Description
Edit file name Edit file names
Copy Protected Files Move Move files to other folders
® When set as wallpaper or ringtone, settings may return to defaults if Slideshow  Show files in a folder continuously. Select display speed
license has expired or different USIM Card is inserted. > Normal or Slow
@ Limited use files cannot be set as wallpaper or ringtone. Delete this  Delete a file
>YES

Highlight a file in Data Folder = (x7)[Menu] for the following operations.

® Some functions may not be available depending on files. skl D;'E;ie?lmf;e Password = YES
M Pictures Multiple- Select multiple files to use
ltem Operation/Description choice > Check files to use + (x7)[Menu] = Select an item
Edit picture  Edit files (£5P9-12) Memory Show memory information
Display picture Open files Status
Set display*  Set as wallpaper, Phone Book image, Menu Icons, etc. Sort Change display order of files
> Select an item > Select an order
® % appears for item. Pictures/ Toggle list view
Picture info  Show file name, file size, etc. File names @ Alternatively, (c)[Change] to toggle
Attach to Send files via S! Mail (C3From Step 2 on P.13-4) Take contents Connect to site for Content Key
S! Mail key
Graphic mail Add selected files to Graphic Mail (C%P.13-9) * Before setting a file as Video Call related item (except for Incoming/
Send Ir data  Send files via Infrared (£%P.10-3) Outgoing Video Calls), set Select Images to Original (Change Outgoing
IC transmission  Send files via IC transmission (£%P.10-5) Image: (5°P.18-12).
Add shortcut Create shortcuts (C%P.1-22) To set a file as Menu Icon related item, set Menu Icons to Customize
icon (P.18-4).
Copy to Copy files to microSD Card @ If incoming calls arrive or handset is turned off while My Pictograms
microSD package file (.gpk) is being uncompressed, some pictograms in package
Move to Move files to microSD Card file may not open. Retry uncompressing.
microSD

Positioning  Set where to paste files in Standby
> Select a position




my
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P ecccccccccccccccccccce
@Enlarge Still Images (C5P.9-6)

@Editing Still Images (5P.9-12)

@Creating Animations (C%P.9-13)

@Saving Still Images to Phone Book (%P.9-14)

M Ring Songs&Tones

Item Operation/Description
Edit file name Edit file names

Item Operation/Description
Sort Change display order of files
> Select an order
Move Move files to other folders
Move to Move files to microSD Card
microSD

Take contents
key

Connect to site for Content Key

Play melody Play back files H Widget
Setasring > Setas ringtone Item Operation/Description
tone ® S appears for item. Paste on ©%P7-2)
Add shortcut Create shortcuts (C3P.1-22) Stand-by
icon Widget Show file names, sizes, etc.
Attach to Send files via S! Mail (C%From Step 2 on P.13-4) Information
S! Mail Attach to Send files via S! Mail (C%From Step 2 on P.13-4)
Send Ir data  Send files via Infrared (C%P.10-3) S! Mail
1C Send files via IC transmission (£%P.10-5) Send Ir data  Send files via Infrared (C%P.10-3)
transmission IC Send files via IC transmission (£%P.10-5)
Copy to Copy files to microSD Card transmission
microSD Move to Move files to microSD Card
Song-Tone Show titles, file names, etc. microSD
info Delete this  Delete a file
Memory Show memory information >YES
Status Delete all Delete all files
Delete > Select a type > Enter Phone Password = YES
- Delete this -+ YES Multiple- Select multiple files to use
- Delete select - Check files to delete = choice > Check files to use = (¥7)[Menu] = Select an item

(=)[Finish] - YES
- Delete all = Enter Phone Password = YES




\H

I S! Appli/Lifestyle-Appli M Videos
Item Operation/Description Item Operation/Description
Start Activate S! Appli or Lifestyle-Appli Register Set as ringtones, Standby Display or Start-up display
Security level Set security level ((%P.15-4) Video info Show titles, file names, etc.
S! Appli info  Show file names, file sizes, etc. Attach to Send files via S! Mail (C3From Step 2 on P.13-4)
Add shortcut Create shortcuts (C%P.1-22) S! Mail
icon Send Ir data  Send files via Infrared (C%¥P.10-3)
Move to Move files to microSD Card IC transmission Send files via IC transmission (C%P.10-5)
microSD (Lifestyle-Appli cannot be moved) Copy to Copy files to microSD Card
Delete Delete files microSD
> YES Move to Move files to microSD Card
microSD
!sMUf ;c tions Available in Chaku-Uta Full’/WMA File List" (£P.8-9 Move Move fies to other folders ?
ee runctions Avariable In haku-Lta fu lle List” (P8-9) Add shortcut Create shortcuts (C3P.1-22) o
icon 2
Edit file name Edit file names 5
Delete this  Delete a file ‘:
>YES 3
Delete all Delete all files v
> Enter Phone Password = YES
Multiple- Select multiple files to use
choice > Check files to use = (7)[Menu] = Select an item
Memory Show memory information
Status
Sort Change display order of files
> Select an order
Listing Change list view
® (a)[Change] to toggle views
Take contents Connect to site for Content Key
key
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I PC Movies I Books
Item Operation/Description Item Operation/Description

Contents info Show titles, file names, etc. Play Play back files
Move Move files to other folders Connectto  Open site link
Copy Copy files to other folders Website
Multiple- Select multiple files to use Book info Show file names, file sizes, etc.
choice > Check files to use = (¥7)[Menu] — Select an item Copy to microSD Copy files to microSD Card
Comment Show descriptions Move to microSD Move files to microSD Card
view Add folder  Add folders
Memory Status Show memory information Edit file name Edit file names
Delete this  Delete a file Move Move files to other folders

> YES Take contents Connect to site for Content Key
Delete all Delete all files key

> Enter Phone Password = YES Delete Delete files
mTv > YES

® See Pictures folder for still images.

Item Operation/Description
Edit title > Enter titles
Video info Show titles, channel names, etc.
Add shortcut Create shortcuts (%P.1-22)
icon
Delete > Select an item

- Delete this = YES
- Delete selected = Check files to delete =

(=)[Finish] - YES
- Delete all = Enter Phone Password = YES

Memory Status Show memory information

Listing Change list view
® ()[Change] to toggle views




my
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M Customized Screen M Templates
Item Operation/Description Item Operation/Description
Preview Preview files Compose Send files via S! Mail (3°P.13-5)
Collective  Set Customized Screen all at once S! Mail
Setting Edit title Edit titles
File info Show titles, file names, etc. Template Info Show title and file size
Copy to microSD  Copy files to microSD Card Delete this > YES
Move to microSD Move files to microSD Card Delete > Check files to delete - (=)[Finish] - YES
Edit file name Edit file names selected
Delete this  Delete afile Delete All > Enter Phone Password = YES
>YES
Deleteall  Delete al fles M Font EX
> Enter Phone Password = YES Item Operation/Description =
Multiple- Select multiple files to use Set A Q
. . ) pply selected font 5
- (v D
choice > Check files t.o use . ()[Menu] - Select an item File info Show file names, file sizes, etc. &
Memory Show memory information — — S
St Edit title Edit titles (]
atus _ i -
Sort Change display order of files Delete this  Delete a file a5
> Select an order > YES : @
Listing Change list view Delete all Delete all files
e (1a)[Change] to toggle views — >|Enter F’lhoTefF]assvvord - YES
; Multiple- Select multiple files to use
Tak tents C t to site for Content K R ) .
kae contents Lonnect fo site for Lontent ey choice > Check files to use = (¥7)[Menu] = Select an item
Connectto  Open site link gllte:'lory Show memory information
Website atus
Sort Change display order of files
> Select an order
Listing Change list view
@ (a)[Change] to toggle views
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I Other Documents

Item Operation/Description
File info Show file names, file sizes, etc.
Attach to Send files via S! Mail (C%From Step 2 on P.13-4)
S! Mail
Copy to Copy files to microSD Card
microSD
Edit file name Edit file names
Move Move files to other folders
Delete this Delete a file
>YES
Delete all Delete all files
> Enter Phone Password = YES
Multiple- Select multiple files to use
choice > Check files to use = (7)[Menu] = Select an item
Memory Show memory information
Status

Sort

Change display order of files
> Select an order

® Titles of mp4/3gp Ring Songs&Tones files and Videos/Music/Customized
Screen files appear in respective lists. Files without titles appear with
file names (created when files are saved to handset). Titles cannot be
changed; edited file names may not appear in lists.

Using/Editing Still Images
I Editing Still Images

® Edit features are not available for all file types.

Main Menu p> Data Folder p> Pictures

Select a folder = Select a file = (x7)[Menu] =
Edit picture

2 (x7)[Menu] = Select an item (See below)

Item

Operation/Description

Marker stamp > Select a stamp = (34 to move stamp — (@)[Put]

@ Following options are available when positioning a
stamp:
- To rotate or scale up/down: (x7)[Menu] -
Select an item
- To start over: (=)[Cancel]
® To add: (=)[Add]

Frame

> Select a frame
- To rotate 180 degrees: (7)[Menu] -
180° rotation
- To change frame: ()
- To return to frame list: (=&)[Cancel]

Character
stamp

> Enter text = (34 to move text = (@)[Put]

@ To change content/color/font/size: When positioning
stamp, (7)[Menu] = Operate selected item

® To start over: (&)[Cancel] after positioning
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Item

Operation/Description

Fit in screen

Change image size to Standby (480 x 854)
>YES

Change size

> Select a size
® To start over: (&)[Cancel]

I Creating Animations
Saving Original Animation

Main Menu > Data Folder p> Pictures p> Original Animation

Trimaway > Specify a size = (39 to specify area - (@)[Set]
® To start over: After specifying area, (&)[Cancel] 1 <New> — <Tst> - <20th>
Retouch > Select an item )
@ Tostart over: (& [Cancell] 2 Selectafolder = Select a file
Rotate > 90° to right, 90° to leftor 180° ® Repeat Step 2.
® To start over: (&)[Cancel] .
- Finish
Brightness > (o) to adjust brightness 3 [ ]
S C'eate S! Mail with edited still images Functions Available in Original Animation List
S! Mail* > (@)[Set] - Create S! Mail (%From Step 2 on P.13-4)
® Edited files are automatically saved. In Original Animation list, press (3xz)[Menu] for following operations.
® Alternatively, (=)[ BE<I] to attach pictures to S! Mail [tem Operation/Description
Save* Overwrite/rename to save edited files Edit title > Enter title
* Available after other editing operations. Org. animation Add more files to an Original Animation (¥Above)
Display Play back an Original Animation
_’
3 @[Seﬂ @[Save] picture @ Alternatively, select an Original Animation from list to
. play back.
4 YES (Overwrite) or NO (Save as) Set display Set an Original Animation as Standby display, etc.
> Select item to set Original Animation as
Picture info  View item set for Set display
Release Cancel a saved Original Animation
animation >YES
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ISaving Still Images to Phone Book

@ Savable sizes:

- Standby (480 x 854) or smaller in JPEG or GIF format (up to 300 Kbytes)

- VGA (640 x 480) or smaller in PNG format
@ Save images to up to 100 Phone Book entries.
@ Still images cannot be saved to USIM Card Phone Book entries.

Main Menu p> Data Folder p> Pictures

Select a folder = Select a file = (¥7)[Menu] =
Set display - Phone Book

New Entry

New - Enter details (= From Step 3 on P.4-4) =
(&)[Finish]

Add to Existing Entry

Add - Select entry - (=2)[Finish] - YES

\H

Managing Folders/Files
I Managing Folders

The following operations are available in Pictures, Music,
Books, Videos, Ring Songs&Tones and Other Documents.

Main Menu > Data Folder

Select a folder = [Menu] — Select an item
(See below)

Item Operation/Description

Add folder  Create user folders
Edit folder  Edit user folder names
name

Delete folder Delete a user folder
> Enter Phone Password = YES = YES

Folder Hide files in folder unless Phone Password is entered
security ' > Enter Phone Password = YES
{2 appears for folder.
@ To cancel: Repeat the step
Delete all > Enter Phone Password = YES = YES
image ?
Edit Play Edit Play Lists
List °
Release Play Cancel edited Play Lists
List 3 > YES




Item Operation/Description
Select Specify folders on microSD Card to save files to
storage * >YES

® Folders cannot be specified when saving Books files.

Memory
Status °

View memory capacity/number of saved files

! Pictures/Videos folders only

2 Pictures folder only

3 Play List folder in Ring Songs&Tones folder only
* microSD Card only

> Music folder only

\H

I Using Play List

Use Play List to organize Data Folder Ring Songs&Tones/
Videos files.

Select Ring Songs&Tones, Music or Videos folder files to
create Play List links to each file in its original folder.

Creating Ring Songs&Tones Play Lists

Main Menu > Data Folder p> Ring Songs&Tones
1 Highlight Play List — (3z)[Menu] — Edit Play List

2 Select a number = Select a folder = Select a file
® Repeat Step 2.

3 (=[Finish]

I Play Back Play List
>Main Menu p- Data Folder p> Ring Songs&Tones »> Play List
® Files are played back in the saved order.

[ Delete a File
> After Step 1, select a file = Release this

[ Delete All Files
>In Step 1, ()[Menu] = Release Play List —» YES

® mp4/3gp files cannot be added to Play List except in Music Player Play
List.
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Creating Video Play Lists

Main Menu p- Data Folder p> Videos »> Play List
1 Select a Play List

2 Select a number = Select a folder = Select a file
® Repeat Step 2.

3 (&)[Finish]

I Play Back Play Lists
>Main Menu p- Data Folder p> Videos b Play List »> Highlight a
Play List » (=)[Play]

@ Files are played back in the saved order.

M Delete a File
> After Step 1, (highlight a file =) (x)[Menu] - Delete this or
DEL all from list - YES

M Change Order
> After Step 1, (7[Menu] = Oder to play = Select a file = Select a

target = (=)[Finish] = (=)[Finish]

\H

microSD Card

® 941P is compatible with up to 2 GB commercial microSD Cards and up
to 16 GB commercial microSDHC Cards (as of May 2009).
For information on memory card compatibility, visit the website
below (Japanese). Note that microSD Cards not listed on the website
may not function properly.
- From Yahoo! Keitai
P-egg (as of May 2009)
Yahoo! Keitai top page » X =21 —UX k - && - V—)b—
T—5 A4 X—H— = P-eqg
- From PC
http://panasonic.jp/mobile/
Not all operations are guaranteed by the microSD/microSDHC Cards
listed.
® Format new microSD/microSDHC Cards for use with 941P (£%P.9-18).

® SoftBank is not liable for damages from accidental loss/alteration of
microSD Card information. Keep a copy of Phone Book entries, etc. in a
separate place.

® microSD Card has no write protect feature; there is a risk of accidental
erasure/overwriting of files.




I microSD Card Installation
® Turn off handset before inserting/removing microSD Card.
Inserting

1 Open cover. Insert microSD Card until it clicks

microSD Card Check

When microSD Card is installed correctly, B appears. If E} appears,
microSD Card cannot be used. Remove microSD Card from handset, and
re-insert it. If E’,’! does not disappear, execute Check microSD (%P.9-21)
or format microSD Card (£%P.9-18).

(Display Indicator: £%P.1-10)

\H

Removing

1 Push microSD Card in
® microSD Card pops out with a light push.

Remove microSD Card and close cover
® To close cover: C¥Left

® Do not turn off handset or remove battery/microSD Card while B
flashes. microSD Card may be damaged or files lost.
@ microSD Card may pop out when inserting/removing it.
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I Format microSD Card

® Formatting microSD Card deletes all saved files/data.
Main Menu p> Tools »> microSD Backup
1 )Menu] - microsD format

2 Enter Phone Password = YES

1 Select a category

® Do not turn handset power off or remove microSD Card or battery while
formatting; may damage handset or microSD Card.

® microSD Cards formatted on other devices may not be used. Format
microSD Card on 941P before use.

® 941P cannot format incompatible microSD Cards.

@ |f format fails, turn power off and remove microSD Card from 941P.
Reinsert microSD Card and format it again.

IViewing microSD Card Files

View Phone Book entries, Calendar events, Tasks, mail
messages, Notepads and Bookmarks backed up on microSD
Card.

Main Menu p> Tools » microSD Backup

[1lPhone Book |
ECalendar
ETasks

Incons =
HSent ;ED
ElUnsent Messages
Hbrafts
EIMemo Pad
ElBookmarks

Category List

G microSD Backup

IE S )
Backup date appears as file name. - TBD

2 Select a file ‘

File List

T p—

3 Select a data ‘

Data List

Aoki Taro 0
Aoki TcTBD
?é:foki Taro
E.090XXXXXXXX
Detailed Data

® [f messages on microSD Card do not appear correctly, copy messages to

handset (C%P.9-19) and execute Charset Conversion (CP.13-22).

g=



I Handset Data Backup

Back up handset data (Phone Book, Calendar, Tasks, Messages,
Notepad, Bookmarks, Content Keys) to microSD Card; restore
handset data after accidental loss/alteration.

@ Back up Content Key: £%P.9-22

Backing up to microSD Card
Main Menu p> Tools » microSD Backup

1 Highlight a category — (37)[Menu] -
Copy to microSD (= For Bookmarks, select an
item)

2 Enter Phone Password = YES

Al files of selected category are backed up to microSD Card.

[ One File Backup
> Open a file = (x)[Menu] - Copy to microSD — YES

Restoring from microSD Card
Main Menu p> Tools »> microSD Backup

1 Selecta category

Restore One Item
Select a file = Highlight an item = (¥7)[Menu] =
Add to phone

Restore One File
Highlight a file & (7)[Menu] = Add to phone or
Overwrite to phone = Enter Phone Password

Restore All Files
(x7)[Menu] = Add all to phone or
Overwr. all to ph. = Enter Phone Password

3 YES

® Note that Overwrite to phone or Overwr. all to ph. erases all files
of same category on handset.

® Files of 10 MB or larger cannot be moved/copied from microSD Card to
handset.

® Data backed up in other SoftBank handsets may not be restored in

941P depending on type and size.

P eceeccccccccccccccoccccoe

@Delete Items from microSD Card @View microSD Card Memory Capacity
(*P9-21)
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I PC File Transfers

Folder Structure

Files moved or copied from 941P to microSD Card are
managed as shown below:
® Save files in folders by file type.

Flash(R)

Flash® files

Games and More

S! Appli

Music

Sound files with .3gp, .mp4, .smc

Other Documents

Other files

Pictograms My Pictograms
Still images moved/copied from
Pictures handset to Main Folder in microSD

Card

Sounds & Ringtones

Sound files of:

up to 10 MB with .3gp, .mp4,
up to 300 KB with .mid, .midi,
.amr

Videos moved/copied from

Videos handset to Main Folder in microSD
Card
Widget Widget contents
. PC Movies saved from PC to
WMFile microSD Card
SD_VIDEO

@ Videos saved to microSD Card

DCIM
® Still images saved to microSD Card
PRIVATE
MYFOLDER
Utility
Calendar Calendar.BCK Calendar Backup files
Contacts Contacts.BCK Phone Book Backup files
Rights Content Key Backup files
Tasks Tasks.BCK Tasks Backup files
Memo Memo.BCK Notepad Backup files
Mail
Drafts Drafts.BCK Drafts Backup files
Inbox Inbox.BCK Incoming Mail Backup files
Outbox Outbox.BCK Unsent Messages Backup files
iﬂe:;[sages ;eCnKt Messages. Sent Messages Backup files
My Items
Book E-comics
Bookmarks | Bookmarks.BCK | Bookmarks Backup files
Custom Screens Familiar Usability applications

® Some copy protected files have extensions different from above.
® \When moving/copying videos from microSD Card to handset, file format

or file size may change.

* If WMFile does not appear in My Items (MYFOLDER), create and save a

folder titled WMFile.




Using Data on microSD Card

With a microSD Card inserted, connect handset with a PC

via USB cable (not included) to read/write data from/onto

microSD Card.

Following equipment is required:

@ Connector Cable: USB cable

® PC: PC with USB port (Universal Serial Bus Specification Rev 1.1
compliant)

® Compatible Operating Systems: Windows® XP, Windows Vista® (Japanese
version in each)

Main Menu b Settings p> Connectivity » USB Mode
» microSD Mode
1 Connect handset to PC via USB cable while 941P is on

® PC recognizes microSD Card.
® B appears in Standby (handset).

® Even if incoming call arrives, reading/writing data continues during
calls. After calls, check indicators on PC to see if reading/writing is
complete.

® File names saved in microSD Card may not properly appear if changed
on PC.

\H

I microSD Card Functions

M Restore microSD Card items (Check microSD)

> Main Menu p Tools p> microSD Backup » (¥7)[Menu]
» Check microSD p- YES

® Do not turn handset power off or remove microSD Card or battery while
formatting; may damage handset or microSD Card.

® |t may take 30 seconds or longer to complete Check microSD depending
on data volume on microSD Card.

® 941P cannot check incompatible or unformatted microSD Cards.

® 941P may delete files and folders that fail to be restored.

M Delete Items from microSD Card

>Main Menu P> Tools > microSD Backup »> Select a category
> (Highlight a file =) (37)[Menu] p> Delete this or Delete all (» For
Delete all, enter Phone Password) > YES

@ Content Key cannot be deleted.

M View microSD Card Memory Capacity
> Main Menu b Tools p> microSD Backup p (3)[Menu]
» microSD info
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I Back Up Content key

Copy Content Keys to microSD Card from handset or to handset from

microSD Card.

>Main Menu p> Settings p> Security p> Content Key
»> Copy to microSD or Copy from microSD p> Enter Phone
Password

@ Content Keys with expiration dates or usage limits cannot be backed up.

® USIM Card inserted when Content Keys were moved to microSD Card
must be inserted to move Content Keys from microSD Card.

® Some applications are made for use on specific models. Some models
move Content Keys to microSD Card instead of backing up. Contact
SoftBank Mobile Customer Center, General Information for more
information.

® Content Keys are backed up after the previous back up file is deleted. To
back up another key and keep existing keys, move existing keys to
handset first and back up a new key.




Infrared
Before Using Infrare
One/Multiple File Transfer
All File Transfers
IC Transmission
One File Transfer.
All File Transfers
Bluetooth®
Before Using Bluetoot
Using Bluetooth®....
Suspending Bluetooth® Function

Placing Bluetooth® Devices on Standby for Connectio
Sending/Receiving Phone Book
Bluetooth® Functions

SoftBank Utility Software (Japanese).
USB (Japanese) ..

Setting USB Mode ..

Transferring Data via USB Cable

Data Communication via USB Cable
AV Output

Connecting Handset to TV
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Infrared
I Before Using Infrared

Transfer Phone Book/Calendar events, messages, bookmarks

and Data Folder files wirelessly between 941P and

compatible devices, including PCs and other mobiles.

® 941P infrared function is based on IrMC1.1, however, some IrMC1.1-
based device transmissions may not be transmitted/received within
specification.

® Debris may inhibit infrared transfers; clean infrared ports with a soft cloth
beforehand.

@ Direct sunlight/fluorescent light may inhibit transfers.

® Align infrared ports within 20 cm of one another and make sure no
objects are placed between them. Do not move the devices until transfer
is complete.

Infrared Port

Transferable Files

Condition . .
Transferable file il ALk
Phone Book (Account Details) O Up to 1000
Calendar events ' O Up to 1000
Tasks O Up to 100
Received message O Up to 3000
Sent message O Up to 1000
Drafts O Upto 10
Notepad O Up to 20
Ring Songs&Tones O —
Still image 23 O —
Video 3 O —
Bookmark
(Yahoo! Keitai, PC Site Browser) o Up 0 100 each
Widget * O —

O: Transferable —: Not transferable

! Saved Holidays/Memorial days not transferable
2 Including Flash® files

3 Multiple files transferable

® Following files cannot transfer:
- Files prohibited for transfers from 941P
- Phone Book entries and SMS on USIM Card
® |f memory becomes full, remaining entries are truncated (Memory List:
%P.19-25).
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I One/Multiple File Transfer
@ Transferable Files: £%P.10-2

Sending
1 Highlight a file, and follow the steps below

Files to Send Operation/Description

Phone Book > (w/[Menu] = Send Ir data - Send phonebook

Account > @[]
Details

Messages > (¥J[Menu] = Send Ir data - Send This

Bookmarks > (w/[Menu] = Send to ExtrnlDvcs — Send Ir data

- Send This

Still Images/ > (x7)[Menu] - Send Ir data

Videos/ ® To send multiple files: (3)[Menu] -

Widgets Multiple-choice — Select files to send = (x7)[Menu]
- Send Ir data

Other Files > (¥/[Menu] - Send Ir data

) YES
Receiving

Main Menu p> Tools p> Receive via Infrared p> Receive

When a file is received, YES

Send files from sender side within 30 seconds.
® To receive subsequent files, select YES.

I All File Transfers

Precaution

® Receiving all files overwrites all saved files including secret/protected
files.
Files saved in Secret Mode are also deleted.

@ Sending all Phone Book entries sends Account Details as well.
User-edited information is overwritten (handset number remains).

Session Number

Session number (4 digits) is required for all file transfers via Infrared and
IC transmission. Sender and recipient must enter same Session number to
complete transfers.

_ 10
Sending A
E
1 Highlight a file, and follow the steps below E
—*
Files to Send Operation/Description 5
Phone Book  (x7)[Menu] - Send Ir data = Send all phonebook =
Messages ()[Menu] - Send Ir data - Send All
Bookmarks  (x7)[Menu] = Send to ExtrnlDvcs — Send Ir data
- Send All
Other Files  (x)[Menu] - Send all Ir data
2 Enter Phone Password = Enter Session number = YES
Recipient must enter the same Session number to start transfers.
10-3
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Receiving
Main Menu p> Tools p> Receive via Infrared »> Receive All

Enter Phone Password = Enter same Session number
as sender's = YES — YES

Saved files are deleted, and transfer starts.

\H

IC Transmission

Exchange files with another IC compatible handset using

reader/writer function.

® Type of files and transfer conditions are same as those for infrared file
transfer (C%P.10-2).
Multiple file transfer is not available.

® |C transmission is not available when /C Card Lock (C¥P.16-5) is
activated.

® \When receiving dada, end all active functions.

@ [f there is difficulty in file transfer, move a 5 ) logo close to or away from
the other logo or move each side up, down, left, or right.

® Data cannot be sent during charging battery.

Align 5) logos of both handsets

i@N
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I One File Transfer

Before Receiving a File

® Receive IC Datum is set to ON by default. When
Receive IC Datum is OFF, One File Transfer is unavailable.

® To set Receive IC Datum on:

Main Menu p> Osaifu-Keitai p> IC Card Settings

P Receive IC Datum > ON

Sending
1 Highlight a file, and follow the steps below

Files to Send Operation/Description
Phone Book > (x7)[Menu] = IC transmission - Send phonebook
Account > (@)[ICtrans]
Details
Messages > (x7)[Menu] - IC Transmission - Send This
Bookmarks > (3)[Menu] = Send to ExtrnlDvcs -
IC transmission = Send This
Other Files > (3)[Menu] - IC transmission
2 YES
Receiving

1 Align 2] logo on sender side with 941P (recipient) =
YES

I All File Transfers

@ Precautions/Session number (%P.10-3)

Sending

1 Highlight a file, and follow the steps below

Files to Send
Phone Book

Operation/Description
> (¥)[Menu] - IC transmission -
Send all phonebook
> (¥)[Menu] = IC Transmission - Send All
> (¥7)[Menu] = Send to ExtrnIDvcs +
IC transmission = Send All
> (¥)[Menu] - AMlIC transmission

Messages
Bookmarks

Other Files

2 Enter Phone Password = Enter Session number = YES
Recipient must enter the same Session number to start transfers.

Receiving
1 Align ) logo on sender side with 941P (recipient)

2 YES — Enter Phone Password = Enter same Session
number as sender's
Saved files are deleted. Transfer starts.

KA1d8uU0) 3
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Bluetooth®

Connect handset to Bluetooth® devices to use functions

\H

below.
Function Device Description
Handsfree Calls Headsets
(©P.10-10) Handsfree devices Talk handsfree on handset

Wireless Playback

Audio devices

Play back sounds (Digital TV/
Video) or music (Music Player)

I Before Using Bluetooth®

Bluetooth® Specifications

Version

Bluetooth® specification Ver.2.0+EDR

Supported Profiles '

HSP (Headset Profile)

HFP (Hands-Free Profile)

A2DP: Advanced Audio Distribution
Profile

(¥P.10-10) wirelessly from external AVRCP: Audio Video Remote Control
speaker Profile
Internet Connect wirelessly to Internet DUNP: Dial-up Networking Profile
Connection PC using handset as external OPP (Object Push Profile)
1 0 (C¥P.10-10) modem Output Bluetooth® Power Class2
Q ls)ﬁr;:::lgBl::kcelvmg pC Send/receive Phone Book Erequenc'y B:-mdi;- - : i.4GHz.(Z.EI(TZtGHz—Z.fSOGHz)
5 o109 Handsets entries wirelessly ommunication .|s ance . ppr.omma ely len me fers .
@ ! Bluetooth® connections are available with compatible devices supporting
= _ the same profile.
é‘ 0000000000000 00000060 00 2 petooth® operates in the 2.4 GHz unlicensed frequency band.Depending
@D @Stop Ringtone Output to Headset/Handsfree Device on other devices in use in the spectrum, Bluetooth® connection may slow
@ Continue Calls on Handset when Bluetooth® is Disconnected down/terminate, or range may decrease.
from Headset/Handsfree Device @Always Make Calls from 941P 3 Affected by distance between devices, obstructions, signal conditions,
even when Headset is Connected @Always Use Handsfree Device handset status, etc.
to Make/Receive Calls (C%P.18-17)
10-6



Notes

® 941P may not be able to establish a Bluetooth® connection with some
Bluetooth® devices.

@ Establish connections with certified Bluetooth® devices that meet the
specification standards developed by Bluetooth® SIG.

® Due to the unique characteristics/specifications of a certified Bluetooth®
device, connections or transfers may fail; procedures, displayed results or
operations may vary from those described in the manual.

® When data transfer is interrupted, it may take some time for process to
complete.

@ Noise may interfere with wireless or handsfree conversations depending
on the status of connected devices or signal conditions.

@ For details about headset/handsfree devices, see the device manuals.

\H

I Using Bluetooth®

Pair Bluetooth® devices with 941P beforehand to establish
connections for different Bluetooth® functions.

Searching & Pairing Devices

Search other Bluetooth® devices.

Paired devices appear in Search&Paired Device list.

@ Bluetooth® Passkey is not necessary for paired devices.

® Search up to 20 Bluetooth® devices at one time; pair with up to ten
Bluetooth® devices.

® Place Bluetooth® devices on standby for connection.

Main Menu p> Tools b Bluetooth p> Search&Paired Device
1 YES*

Device search starts and names of found devices appear.

® To search again: (&)[Search]

*If there are already paired devices in list, select a device = Select a
function

2 Select a device = YES = Enter Phone Password

Select text entry field = Enter Bluetooth® Passkey

w

4 Select a Bluetooth® function

V/ __Next Page 4

KA1d8uU0) 3
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941P connects to Bluetooth® device. When complete, & flashes in
blue. After no Bluetooth® connection is made for a certain time,
€ appears in black and Power saver mode starts.

® When Bluetooth® device can connect to multiple services,

confirmation appears asking whether to connect to another service.

@ While connected, [%|(Blue) appears. While in Standby, [ (Gray)
appears.

® When Dial-up is selected, 941P stands by for connection requests
from other Bluetooth® devices.

® Dijal-up can be selected regardless of profile types.

Bluetooth® Passkey
Bluetooth® Passkey (1 to 16 digits) is required to connect
Bluetooth® devices; sender and recipient must input the same code to

10 complete file transfers.
Q @ Bluetooth® Passkey is not necessary for paired devices.
=
2 W Search&Paired Device List
2 ©Device Type
= Indicators appear for different & Search&Paired Dev.
=< types of devices.
@ Device Name TSI
Device names appear. [®] DUNHFP HSFEFIROPP
When no names are found, Search&Paired Device
Bluetooth® addresses appear.
@ Connection Status
[@]: Connected [O]: Not connected [X]: Not found [&]: Not paired
10-8
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O Protection

Indicator appears when registered contents are protected.
@ Profile Status

Indicators appear to show profile status.

Icon | Letter Color |Background Color | Frame Color Status

Blue Gray - Not connected (Not paired)
Blue Gray Blue | Not connected (Paired)
EEZd | White Green - Connected

Green White Green | Standby for connection
HSP White | Light green - Preferred device

Gray Gray - Not supported

PP eecccccccccccccccccccoe
(ETTTD @Set Duration to Search for Bluetooth® Devices ((%P.18-17)

=
S

I Suspending Bluetooth® Functions

Suspend all Bluetooth® functions connected or on standby
for connection, and disable Bluetooth®.

Main Menu p> Tools p> Bluetooth

1 Bluetooth OFF - YES

® To return to standby for previously connected function:
Bluetooth ON




Placing Bluetooth® Devices on Standby for
Connection

Main Menu b Tools »> Bluetooth p> Accept Registered

Check functions to be on standby for connection =

(&)[Finish]

® To uncheck, select functions to remove check marks.

I Sending/Receiving Phone Book

Sending
1 Open Phone Book - (x7)[Menu] -
Send to Bluetooth

2 One File Transfer
Send phonebook — Select a recipient device

All File Transfer
Send all phonebook — Select a recipient device =
Enter Phone Password

3 YES

\H

Receiving

Main Menu p> Tools p> Bluetooth > Receive via Bluetooth

One File Transfer
Receive = YES

All File Transfer
Receive All = Enter Phone Password = YES — YES

® [f memory becomes full, remaining entries are truncated (Memory
List: C%P.19-25).

JiPeceeccccccccccccccoccccoe
ITTD @Set Authentication/Encryption to Send Phone Book Entries

@Etnter Password when Sending All Phone Book Entries
([C%P.18-17)

KA1d8uU0) 5‘
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I Bluetooth® Functions
(From Jp Main Menu p> Tools b Bluetooth

M Functions Available in Search&Paired Device Window
> Search&Paired Device - (x7)[Menu] = Select an item (See below)

Item Operation/Description
Register > Enter Phone Password = Pair devices
devices (%From Step 3 on P.10-7)
Preferred Set a preferred Bluetooth® device for incoming calls
device ® Available only for headset function compatible
Bluetooth® devices.
® To cancel, perform same operation.
10 Protect/ Protect/cancel devices. Protection prevents devices from
A release being deleted or overwritten
] Change > Enter a device name
2 device name
%. Delete > YES
é‘ Description  Show device name, Bluetooth® address, device class and
supported profile
Add shortcut Create shortcuts (C%P.1-22)
icon
B Make/Receive Calls via Bluetooth®
> Search&Paired Device - Select a device & Headset or Hands-free
— YES = Make/receive a call using Bluetooth® device
10-10
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I Use Bluetooth® Device for Wireless Playback

> Search&Paired Device — Select a device = Audio = Watch Digital
TV or play back videos or music

® Digital TV/Video sounds are played only by A2DP profile compatible
Bluetooth® devices compliant with SCMS-T copyright protection
standard.

I Connect to Internet Using Bluetooth® Device

> Search&Paired Device — Select a device = Dial-up

® 941P waits for dial-up connection.

@ Refer to a manual for Bluetooth® device for details.
Download utility software (941P) "Modem Wizard" from website below
to PC and install software.
http://panasonic.jp/mobile/support/download/941p/index.html

® To establish a dial-up connection, see Help on "Modem Wizard."

® Connecting handset to a PC or PDA for Internet access may incur high
packet transmission charges.

I Place Bluetooth® Device on Standby for Dial-up
> Dialup Rgstry Standby — Enter Phone Password = YES = Select
Bluetooth® Passkey text box = Enter Bluetooth® Passkey



\H

SoftBank Utility Software (Japanese)

Phone Book, Calendar, Tasks, messages, Bookmarks,

Notepads and Data Folder can be transferred to a PC, edited

or managed by using SoftBank Utility Software.

@ For details on and downloading SoftBank Utility Software, visit
http://mb.softbank.jp/r/utilitysoft/cd/ (Japanese)

® USB cable (not included) is necessary for using SoftBank Utility
Software.

® S! Appli, PC Movies, TV, Lifestyle-Appli, Books, Customized Screen,
Templates and Other Documents cannot be backed up.

® Copy protected files may not be backed up.

® Set USB Mode to Communication Mode ([CFRight).

USB (Japanese)

Connect 941P to a PC via USB cable (not included) specified
by SoftBank for data transfer or data communication.

I Setting USB Mode

<Default> Communication Mode
Main Menu p- Settings P> Connectivity » USB Mode

1 Select an item (See below)

Item Operation/Description
Communication Packet transmission, 64K data transmission, data transfer 1 0
Mode and calls with USB handsfree compatible devices are A
available (Left) S
microSD Read/write data on microSD Card (C%P.9-21) 2
Mode 2
MTP Mode  Transfer/delete music data via Windows Media® Player on s
PC (C%P.8-4) <
ITransferring Data via USB Cable
@ Transfer data using SoftBank Utility Software (C%Left).
® Transferring data in microSD Mode (C%P.9-21)
10-11

PR



Data Communication via USB Cable

Use 941P as a modem for Internet access by connecting
941P with a PC.

1

2

KA1d8uU0) 3
W
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Download utility software from URL below and install on PC.
http://panasonic.jp/mabile/support/download/941p/index.html

Install "USB N =~/ \ (USB Driver)" and "Modem
Wizard" from Utility Software (941P) to a PC

Set 941P to Communication Mode (Z#P.10-11), and
connect 941P to PC via USB cable

® Power up 941P before connecting to PC via USB cable.

Start up "Modem Wizard", and operate communication

setup

® "Modem Wizard" enables you to set up APN and dial-up easily.
For setup/starting procedures, see "Modem Wizard" Help.

® Connecting handset to a PC or PDA for Internet access may incur high
packet transmission fees.




AV Output 3 Connect video output cable to video/audio input

View the following on a TV set or other devices using a terminal on TV set

SoftBank-specified video output cable (not included): Video 0 . fil 941p
Call images, Digital TV images, still images/videos saved on 4 pen an image fiie on
941P. ® To toggle display size:

® View AV-output-compatible S! Appli on TV.

) ® Some images cannot be displayed on TV.
I Connecting Handset to TV ® Display size setting is not available for some TV sets.

@ To use video output cable (not included), Stereo Earphone Conversion
Cable (not included) is required.

= )
o
— g
N ] )
e Video output cable 2
<
Video © Q\le”ﬂ < [ mme E
. White
Audio L © ===
Audio R © 42
External Port
1 Open External Port Cover
2 Connect video output cable to handset using
conversion cable
@ To connect video output cable to conversion cable: £%P.1-4
10-13
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Changing Phone Password

\H

PIN Authentication

<Default> 9999 | Activate to require PIN entry each time handset is turned

Change Phone Password as required.
® For Phone Password details: £%P.1-28

Main Menu p- Settings > Security p> Change Phone Password

1 Enter current 4-8-digit Phone Password

72 Enter new 4-8-digit Phone Password = YES

Security Functions
| USIM PINs

@ For more information about PINs: C%P.1-3

on.
Main Menu p- Settings P> Security p> PIN Authentication

1 Enter Phone Password = PIN Authentication

2 ON

® To deactivate PIN Authentication: OFF

3 Enter PIN

Changing PIN/PIN2

® Set PIN Authentication to ON before changing PIN (C¥Above).

® Emergency numbers (110, 119, 118) are not dialable in PIN/PIN2,
PUK/PUK2 entry window.

Main Menu p- Settings P> Security »> PIN Authentication

1 Enter Phone Password = Change PIN or

Change PIN2
2 Enter current PIN/PIN2
Enter new PIN/PIN2

w

4 Reenter new PIN/PIN2




PIN Lock & Cancellation (PUK/PUK2)

PIN Lock or PIN2 Lock is activated if PIN or PIN2 is

incorrectly entered three times. Cancel PIN Lock or PIN2

Lock by entering PIN Unblocking Key (PUK/PUK2).

@ For information about PUK/PUK2, contact SoftBank Mobile Customer
Center, General Information (C%P.19-34).

1 In PIN lock mode, enter PUK/PUK?2
2 Enter new PIN/PIN2
3 Reenter new PIN/PIN2

® |f PUK/PUK2 is incorrectly entered ten times, USIM Card is locked and
handset is disabled (Even turning off power is counted as one incorrect
entry.). Write down PUK/PUK2.

® For procedures required to unlock USIM Card, contact SoftBank Mobile
Customer Center, General Information (C%P.19-34).

\H

I Keyguard

Lock handset keys to prevent accidental operation except
when turning power on/off or answering incoming calls.

1 I Standby, press and hold (@)

When Keyguard is set, (& appears.
® To cancel Keyguard, repeat operation.

While Keyguard is Active

® Emergency numbers (110, 119, 118) are dialable even when Keyguard
is active. Entered numbers do not appear on Display. Once numbers
are dialed, Keyguard is canceled.

® Press (=) to disable Calendar event tone or Alarm.

® Keyguard can be canceled even during a call.

® Turning off power cannot cancel Keyguard.

£31andag 1aspuey E
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I Privacy Key Lock

<Default> OFF

Set Privacy Key Lock to require Phone Password for using
941P except for turning handset on/off and answering calls.

Main Menu P> Settings > Security p> Privacy Key Lock

Enter Phone Password

When Privacy Key Lock is set, flg appears in Standby.
® To cancel Privacy Key Lock, enter Phone Password in Standby. If
Phone Password is incorrectly entered five times, 941P turns off.

While Privacy Key Lock is Active

® Emergency numbers (110, 119, 118) are dialable even when Privacy
Key Lock is active.

@ Only phone numbers appear on Display for incoming calls.

@ Calls cannot be received by Bluetooth® headsets or handsfree devices.

® Message ringtones or Alarm tones are disabled.

@ Calendar event tone or Alarm is disabled.

® S! Quick News and some indicators on Internal Display do not appear.
They appear after Privacy Key Lock is canceled.

@ Turning off power cannot cancel Privacy Key Lock.

£3andas 1aspuey E
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I Personal Data Lock

Set Personal Data Lock to prevent others from reading or
tampering with your personal information in Phone Book or
Data Folder. Activate to require Phone Password for

accessing personal data.

M Locked Functions/Data
- Messaging
- SI Appli

- Phone Book search/saving/setting
- Memory Manager/ Memory Status

(Phone Book)
- Account Details
- Restrictions (Phone Book)
- Notepad
- Calendar
- Tasks
- Shortcuts
- Event Indicators
- Camera/Video Camera
- Lifestyle Appli
- microSD Backup
- Answer Phone
- Voice Recorder
- Customized Screen
- Voice Announce
- Software Update

* Font setting is available.

- Yahoo! Keitai viewing/setting

- PC Site Browser viewing/setting
- Bookmarks/ Saved Pages

- BookSurfing®

- e-Book Viewer

- Mobile Widget

- SI Quick News

- S! Information Channel/Weather
- Content Key obtaining/backup

- Voice Dial

- SI'GPS Navi

- Data Folder*

- Music Player

- Digital TV

- Bar Code Reader

- Receive via Infrared

- |C Data transmission

- Alarm

- Reset Settings

- All Reset



Activating/Canceling Personal Data Lock

<Default> Deactivate

Main Menu p- Settings p> Security p> Personal Data Lock

Enter Phone Password = Activate/Deactivate

While Personal Data Lock is set, g appears in Standby.
@ To cancel Personal Data Lock, repeat operation. If Timer Lock at

Close is set, password entry is requested when 941P is opened.

Canceling Personal Data Lock Temporarily

When Phone Password is entered, 2 disappears and disabled functions

become temporarily available.

@ Once handset returns to Standby while no functions are active,
Personal Data Lock is active again.

@ Some functions remain unavailable. Deactivate Personal Data Lock to
use the following:
- Receiving IC data - Reject unknown

Enter Phone Password = Customize — Select an
item (See below)

Item Operation/Description
Alarm Tone  Enable/disable Alarms (Calendar, TV timer, or other alerts)
or TV Timer Recording.
> Select an item = Accept (Enable) or Not Accept
(Disable)
Incoming Call Show/hide Event Indicator (incoming messages) or Phone
Act Book entry information (incoming calls).

> Select an item
- Incoming Message - Accept (Show indicator) or
Not Accept (Hide indicator)
- Phone Book Available = Accept (Show Phone
Book Entry information) or Not Accept (Hide
information)

® While Personal Data Lock is set, some indicators do not appear in
Standby. They appear after lock is canceled.
® Turning off power does not cancel Personal Data Lock.

Customizing Personal Data Lock

Enable/disable Alarm, incoming message notification, etc.
while Personal Data Lock is active.

Main Menu p- Settings »> Security »> Personal Data Lock

Display/Tone Enable/disable Display settings, ringtones or indicators.
> Select an item

- Internal Display = Accept (Enable Display
Settings) or Mot Accept (Disable)

- Ring Tones = Accept (Enable Sound Settings) or
Not Accept (Disable)

- §! Quick News — Accept (Show information) or
Not Accept (Hide information)

- S! Info Ch./Weather - Accept (Show indicators)
or Not Accept (Hide indicators)

- Widget Contents = Accept (Show widgets) or
Not Accept (Hide widgets)

£31andag 1aspuey E
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Activating Personal Data Lock when Closing Handset

<Default> Deactivate

Set Timer Lock at Close to automatically activate Personal
Data Lock when specified time has elapsed after 941P is
closed.

Main Menu b Settings »> Security »> Timer Lock at Close
1 Enter Phone Password

2 Personal Data Lock — Select a time

Confirmation appears asking whether to activate Lock OFF at Open.
When Timer Lock at Close is set, g appears.
® \When OFF is selected, setting is canceled.

Opening Personal Data Lock OFF Window when
Opening Handset

<Default> OFF
Main Menu p> Settings p> Security > Lock OFF at Open

1 Enter Phone Password

2 Personal Data Lock - ON

® When Timer Lock at Close and Lock OFF at Open are both active,
canceling Personal Data Lock when opening handset temporarily
cancels lock. However, lock activates again when specified time elapses
after closing 941P.

I Secure Remote Lock

If handset is lost or stolen, remotely lock handset from a PC
or mobile. If Secure Remote Lock is active, all operations are
unavailable except to turn handset on.

® For service details and user agreement/registration, visit SOFTBANK
MOBILE Corp. Website (http://www.softbank.jp) or My SoftBank.

Accessing My SoftBank from Handset (Japanese)

For service details, visit SOFTBANK MOBILE Corp. Website.

Main Menu p> Yahoo! Keitai P> Yahoo! Keitai
P X=Za—UZ k p My SoftBank p> English

® Follow onscreen instructions.

® Emergency numbers (110, 119, 118) are dialable even while Secure
Remote Lock is set.
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Showing Messages during Secure Remote Lock

<Default> OFF

Set Display message to appear when Secure Remote Lock is
active.

® Use preset message or create a message.

Main Menu b Settings »> Security > Lock Message
1 Enter Phone Password

2 Display Setting - ON

I Save Lock Messages
> After Step 1, Message — Enter a message

I Key Pad Dial Lock

<Default> Deactivate

Allow dialing only from Phone Book entries and lock dialing
with keypad. Unauthorized use of 941P can be prevented.

I Unavailable Operations
- Dialing with keypad

- Phone Book (saving, editing, deleting, copying from microSD Card, and
sending/receiving via Infrared, IC transmission and Bluetooth®)

- Sending S! Mail/SMS

I Available Operations
- Dialing from Phone Book or Voice Dial

- Dialing from Redial, Outgoing Call Logs, Incoming Call Logs, Sent

address, or Received address (only phone numbers/mail addresses saved
in Phone Book)

Main Menu p- Settings »> Security P> Key Pad Dial Lock

Enter Phone Password

While Key Pad Dial Lock is set, é appears in Standby.
® To cancel Key Pad Dial Lock, repeat operation.

® Emergency numbers (110, 119, 118) are dialable even while Key Pad
Dial Lock is set.

£31andag 1aspuey E
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I Side-keys Guard

<Default> OFF

Set Side-keys Guard to disable side key operations while
941P is closed.

Main Menu P> Settings p> Phone Settings > Side-keys Guard

ON
sie

While Side-keys Guard is set, “g’ appears in Standby.
® To set Side-keys Guard to OFF, repeat operation.

Restricting Calls/Messages

I Hiding Call Logs and Sent/Received Address List
<Default> ON

Main Menu b Settings »> Incoming Settings »> Call Logs

1 Enter Phone Password

2 Select an item (See below)

Item Operation/Description
@ When Menu Icons is set to Standard or Customize, press (@) in Incoming Show/hide Incoming Call Logs/Received address list
Standby = Press and hold to toggle ON/OFF. Outgoing Show/hide Redial/Outgoing Call Logs/Sent address list
pl . OFF
I Additional Lock Functions 3

M IC Card Lock
Deactivate Osaifu-Keitai® functions (C%P.16-5).

M Remote Lock
Deactivate Osaifu-Keitai® functions remotely (C%P.16-5).

® While Incoming Call Logs is OFF, Answer Phone (Voice Calls) does not
play. Selecting Missed Call indicator does not show Incoming Call Logs.




I Secret Mode/Secret Data Only

<Default> Deactivate

Phone Book entries and calendar events saved as secret

data appear only when 941P is in Secret Mode/Secret Data

Only.

® Set Phone Book or Calendar events as secret data (Phone Book: c¥P.4-7,
4-8 / Calendar events: C%P.12-5)

Main Menu P> Settings > Security

1 Select an item (See below)

Item Operation/Description
Secret Mode View all data including secret data

Secret Data
Only

2

View only secret data

Enter Phone Password

For Secret Data Only, number of saved secret data appears.
When Secret Mode/Secret Data Only is set, g appears (For Secret Data
Only, indicator flashes.).

I Cancel Secret Mode/Secret Data Only
> In Standby, or follow Step 1 above

I Cancel Secret Mode/Secret Setting
> In Phone Book/Calendar event window, (x7)[Menu] - Release secret

@ Select whether to save data edited/saved in Secret Mode as secret data.
Data saved/edited in Secret Data Only are saved as secret data.

JiPeececcccccccccccccccccoe
ETITD @Set Learning Feature Off for Secret Mode/Secret Data Only

(P.18-10)

I Setting Secret Mail

<Default> ON

Set messages from secret Phone Book entries to appear only
when handset is set to Secret Mode or Secret Data Only.

1 - Settings

2 Universal Settings ~ Secret Mail Display
3 Enter Phone Password

/A OFF

® When both Spam Filter and Secret Mail Display are set, messages from
Phone Book entries saved as secret mode are sorted into Spam Folder
(Safe List: £%P.13-17).

£31andag 1aspuey E
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I Mail Security

Set handset to require Phone Password for opening mail
boxes or operating Server Mail.

1 - Settings
2 Universal Settings — Mail Security

Enter Phone Password = Select items* — [Finish]

* To cancel: press (@) again.
[ appears for set mail boxes and menus.

I Set/Cancel Mail Security by Incoming Mail Folder

m > (=) - Incoming Mail - Highlight a folder - ()[Menu] -

Mail Security — Enter Phone Password

= ® (@ appears for set mail boxes and menus.

2

w

)

w

©

n

s

=

<
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I Call Restrictions

Reject/accept/forward calls from specified phone numbers,
or restrict calling unspecified phone numbers.

1 (L)~ Search Phone Book

Select an entry = (¥7)[Menu] - Restrictions

2
3 Enter Phone Password
4 Select an item (See below)

Item Operation/Description
Restrict Allow calls only to specified numbers
Dialing

Call Rejection Reject specified numbers

Call Accept from specified numbers only

Acceptance

Call Automatically forward specified numbers

Forwarding @ Set destination numbers (Call Forwarding: C%P.2-17)

® To cancel, repeat operation.

I View/Cancel Phone Book Restrictions

> Main Menu »> Phone Book p> Restrictions > Enter Phone Password
P> Select an item™ P> Select a Phone Book entry B> Select a number
> YES

* S appears for set item.

® Highlight an item, (x7[Menu] — Release Settings — YES to cancel
restriction on all specified numbers.
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® Missed call indicator appears in Standby for calls from rejected
numbers.

I Delaying Ringtone

<Default> OFF

Delay ringtone/vibration for Voice/Video Calls from unknown
numbers.

Main Menu p> Settings P> Incoming Settings
p> Ring Time Settings »> Ring Starting Time

1 ON — Enter start time

M Hide Missed Call Records (Disconnected during Ringtone
Delay)

>Main Menu p> Settings P> Incoming Settings
P Ring Time Settings > Missed Calls Display > Not Display

I Rejecting Unknown Callers

<Default> Accept

Main Menu p> Settings »> Security > Reject Unknown

1 Enter Phone Password - Reject

I Rejecting Calls without Caller ID

<Default> Accept

Reject calls without Caller ID or from pay phones.
Main Menu p- Settings »> Security p> Call Setting w/o ID

1 Enter Phone Password

2 Select an item = Reject

£31andag 1aspuey E
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Reset
I Reset Settings

Cancel custom settings and return handset functions to their
default settings.

Main Menu P> Settings P> Security > Reset Settings
1 Enter Phone Password = YES

® Some default settings may not be restored.
® Reset Settings cancels Navi Appli settings in S! GPS Navi. Set a
Navi Appli to activate from Select Navi Appli (C5P.18-22).

£3andas 1aspuey E
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I All Reset

Cancel custom settings and return handset functions to their
default settings; clear all Phone Book/Data Folder entries
etc.

Main Menu p> Settings P> Security > All Reset
Enter Phone Password = YES = YES

941P automatically turns off and restarts.

@ Fully charge battery ( [E]) beforehand.
® Phone Password is reset to default.
@ USIM Card/microSD Card files are not affected.
® Data transmission settings (set via PC) are not affected.
® Non-restorable items when deleted by All Reset:
- Customized settings, Call Logs, downloaded S! Appli, etc.
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Calendar

View by day, week or month; set Alarms for events.

I Opening Calendar

Main Menu p> Tools p> Calendar

Current month appears.

® When a date with Calendar events is selected, number of AM and PM
events and up to three contents appear.

® (&)[Prev.] or (a)[Next] to show previous/next month calendar.

® To switch Monthly/Weekly view: C%P.12-4

W 2009/ 6/ 6(Sat)

Sun Mon Tue Wed Thu Fri Sat
1 2| 3] 4 SEN3
7| 8 910 1] 12
15| 16/ 17, 18| 19
22| 23 24| 25| 26
29| Jo

l
2 B 1
©11:35 Scheduled
2311:40 Shopping
1112:30 Meal

[Wev | [Hem |
ro B gl o

Monthly View

\H

I Creating Calendar Events
Save up to 1000 entries.
Main Menu p> Tools p> Calendar

@ to highlight a date =
.[New] — Schedule

[ Edit schedule
O cheduled (No Tltle)
@MWhole day
@Date (from)

2009/ 6/ 6 10:10

S LB,

CoRepeat OFF|
GAlarm OFF|
HTone Clock Alarm Tone|
[#Contents

2 Select an item (See below)

Item Operation/Description

Selecticon/ > Select an icon = Edit subject

Edit summary

Whole day > OFF or ON

setting ® When ON is set, Alarm goes off at 0:00 a.m.

Date (from) > Enter start date and time

Date (to) > Enter end date and time

Repeat > Select a repetition = (For Select day, check days
- (=)[Finish])

Alarm > Select an Alarm type (= For ON/Set time, enter time)

® Alarm Tone: C3P.12-6

Alarm tone > Select an Alarm tone type — Select a folder = Select
an Alarm tone

Contents > Enter event description

PR
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3 (&)[Finish]

Calendar Event Indicators

Following indicators appear in Calendar Window.

M (Blue): Morning event

M (Orange): Afternoon event

_ (Underscore): Event that lasts for two days or longer

® Following indicators appear on Display.

: Alarm @ : Monthly
I3 : Daily Yearly
- Weekly

® Calendar events between 00:00 on 2000/01/01 and 23:59 on
2037/12/31 can be saved on 941P.
® Alarm tone does not sound when Privacy Key Lock or Personal Data

Lock is set. However, settings can be changed even while Personal Data
Lock is set (C%P.11-5).

\H

I Saving Holidays/Memorial Days

Save up to 100 entries (one entry a day) each for Holidays
or Memorial days.

Main Menu p> Tools p» Calendar

1 Highlight a date — (=)[New] — Holidays or
Memorial days

2 Select an item (See below)

Item Operation/Description

Date setting > Enter a date

Repeat > Select a repetition type

® 1 time does not repeat Holidays/Memorial days
events.

Edit holiday/ > Enter description
anniversary

3 (=[Finish]

Indicators
Holidays appear in red.
Memorial days are marked with a red circle.

® Following indicators appear in Calendar/Calendar Event List Window:
% : Holidays ~ /# : Memorial days : Yearly repeat

-
N
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IViewing/Editing Calendar Event Details

Main Menu p> Tools p> Calendar

1 p24 to select a date s 2009/ 6/ 6(Sat)

T
@ Schedule

E111:40 |
BShoTns D
E112:30~13:00
fi Meal

Calendar Event List

Select an event B Schedule

. . . @ Summary
@ To edit: (@)[Edit] - Edit selected item Scheduled
(Schedule: % From Step 2 on P.12-2/ Obate (from)

@MWhole day OFF|
Holiday, Anniversary: C%From Step 2 on 2009/ 54 £452E) 11:35

@Date (th
P.12-3) 2009/ 6/ 6(Sat) 11:35
CoRepeat OFF|
EAlarm OFF|

“Contents

Scheduled

Calendar Event Details

I Calendar Functions

(From Jp Main Menu p> Tools p> Calendar

M Functions Available in Calendar Window
> Highlight a date = (3)[Menu] = Select an item (See below)

Item Operation/Description

Weekly Toggle Monthly/Weekly view

display/

1 Month

Icon display  Entries in category of selected icon appear
> Select an icon

No. of Display number of saved Schedule, Holiday or Anniversary

schedules entries

Add shortcut Create a shortcut (C%¥P.1-22)

icon

Send all Ir (C¥P.10-3)

data

AlliC ([C%P.10-5)

transmission

Delete past  Delete past entries/items, prior to highlighted date
> Select a category to delete = YES

Delete all > Enter Phone Password = Select an item = YES

Reset Restore deleted Holidays

holidays > YES

M Functions Available in Calendar Events List/Details
> Select a date (= Select a Schedule, Holiday or Anniversary) =
(x)[Menu] = Select an item (See below)

Item Operation/Description

New Create a new entry (C5P.12-2, P.12-3)

Item Operation/Description
New Create a new entry (C¥P.12-2, P.12-3)
Edit Edit selected item (% Left)
Copy Copy an entry to another day
> Enter date and time to copy an entry to
Calendar Switch from Icon display to Calendar display
display
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Item

Operation/Description

Icon display

Entries in category of selected icon appear
> Select an icon

Tasks

Make quick notes of task to manage in Task list.

Set secret Activate/deactivate Secret Mode o

mode/ > YES (= For Set secret mode, enter Phone Password) I Savmg a Task

Release ® Secret entries appear only in Secret Mode or -

secret Secret Data Only (7¥P.11-9). Main Menu » Tools p> Tasks

Compose Create S! Mail by copying event date and content to :

S! Mgil message text (C;Fro[r;yStgep 2 on P.13-4) 1 [NeW] = Select an item (See below)

Send Ir data  (C5P.10-3) ® To check saved Tasks, select a Task. To edit, press (@)[Edit] in detail

Sendalllr  (£%P.10-3) window.

data Item Operation/Description

IC (C¥P.10-5) Edit Tasks > Enter content

transmission Due date > Select how to enter due date = Enter due date

AllIC (C%P.10-5) ® Select Mo date to enter none.

transmission Priority > Select a priority level

Copy to Copy an entry to microSD Card Category > Select a category

microSD > YES Alarm > Select an Alarm type (= For ON/Set time, enter time)
® To display data on microSD Card: £%P.9-18 ® Alarm Tone: £%P.12-6

Delete this > YES Alarm tone > Select an Alarm tone type = Select a folder =

Delete past  Delete past entries/items, prior to highlighted date Select an Alarm tone

> Select a category to delete = YES

Delete select

> Check entries to delete = (=)[Finish] - YES

2 (=)[Finish]

® \When content is not entered, Tasks cannot be saved.

® Alarm tone does not sound when Privacy Key Lock or Personal Data
Lock is set. However, settings can be changed even while Personal Data
Lock is set C%P.11-5).

-
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I Using Tasks
In Tasks window, press (37)[Menu] for following operations.
Item Operation/Description
New Create a new entry (C3P.12-5)
Edit Edit an entry (€%P.12-5)
Change Change status indicator shown in Tasks list
status > Select a status (= For Completion, select an item —
Enter Completion date)
® Overdue status indicator turns red.
Show by > Select a category
category
Sort/Filter Sort list by due date, entry order, status, etc.
> Select a condition
Add shortcut Create a shortcut (C%P.1-22)
icon
Send Ir data (%P.10-3)
Send all Ir (C%P.10-3)
data
IC transmission (C%P.10-5)
AlllC (C%P.10-5)
transmission
Copy to Copy a Task to microSD Card
microSD >YES
® To display data on microSD Card: C5P.9-18
Delete this > YES
Delete select > Check entries = (=)[Finish] - YES
Delete Delete an entry in Completion status
completed >YES
Delete all > Enter Phone Password = YES

\H

Alarms
IAIarm Tone

When scheduled time arrives, alarm tone sounds and

Notification Light illuminates.

@ For Calendar events and Tasks, alarm message and animation
corresponding to selected icon appear on Display.

To Stop Alarm Tone for Calendar Events, Tasks or Alarm
Press any key.

Missed Alarm

"Missed Alarm" Event Indicator appears in Standby for alarms missed
during Privacy Key Lock, Personal Data Lock or Infrared transmission once
locks are canceled or transmission ends. Select indicator to view content.

® When one or more Alarms are set to the same time, alarm sounds in
the order of : "Alarm" = "Timer Recording" = "Tasks" = "Calendar"
= "Timer Watching"
For Tasks, "Missed Alarm" indicator appears.
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I Setting Alarm

Set up to 12 alarms. Alarm tone sounds at the specified time
once, everyday or weekly as set.

Main Menu p> Tools p> Alarms

1 Highlight an Alarm - (=)[Edit]

‘@Alarm OFF
OTime -l
ORepeat OFF|
»Tone =) Fyrm Tone|
‘Q“Alarm;rBDLevel 4
&Snooze OFF
©Prefer manner mode ON|

2 Select an item (See below)

Item Operation/Description
Alarm (Alarm Activate or cancel Alarm
on/off) > ON or OFF
Time setting > Set Alarm time

Repeat > Select a repetition (—= For Select day, check days =
(=)[Finish])
Alarm tone > Select an Alarm tone type = Select a folder =

Select an Alarm tone
Alarms (Alarm > () to set Alarm tone volume

volume)

Snooze > ON or OFF (- For OFF, enter time)

setting ® When Snooze is set to ON, Alarm tone sounds for 60
seconds, repeating up to six times at five minute
intervals.

Prefer >ON or OFF

manner mode ® Set Manner Mode or Alarm priority.

3 (=)[Finish]

& appears.

Alarm Indicators
® Following indicators appear:

: Repeats daily : Repeats weekly

M Cancel & Reactivate Alarm

> In Alarms list, press (x7)[Menu] = Select set this or Release this -
YES

@ Cancel or reactivate an alarm entry as required.

® Highlight an entry = (@) to reactivate/cancel Alarm.

I Cancel Snooze
> Press any key = (=)

® Copy protected files may not be set as Alarm tone.

® Alarm tone does not sound when Privacy Key Lock or Personal Data
Lock is set. However, settings can be changed even while Personal Data
Lock is set (C5P.11-5).
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Calculator Notepad

Main Menu p> Tools p> Calculator Save up to 20 notes.

Operation Assigned key I Saving a Note
Number (0-9) | (© - .
Main Menu p> Tools » Notepad
+ (=
- ©) 1 <Not Recorded> T
) [1] <Not Recorded> |
X ®) ® Select a saved note to view content. E énot secorgeg;
B B ot Recorde
= @ @[Edlt] to edit. LI <Not Recorded>
3 Mot Recordeds
= ot Recorde
(o) 0 7 Entertext )
i i - i - ot neciucu.
Decimal point — ® Up to 256 double-byte or 512 single-byte g dor Pesilon g
% = characters can be entered. [ <Not Recorded>
}7 I E <Not Recorgeg>
bu7e) <Not Recorded>
- Clear M <Not Recorded>
= Example: [ tenu |
o Le ccty
% -17+28.5=11.5
© (=9 (o) Notepads Window

12-8



I Notepad Functions

In Notepad list window, press (x7)[Menu] for following operations.

Item Operation/Description
Edit Edit a saved note
Compose Create S! Mail by copying content to message text

S! Mail (5 From Step 2 on P.13-4)

Edit schedule Copy a note to Schedule to create a Calendar event
> Schedule = Save a new note (C3From Step 2 on

\H

Dictionary (Japanese)

Use —% 4 TOOL<EE> to access dictionaries (i 5 /\
A0 - FOTEEEE and 2 EEEREE).
® 7 —%5 ATOOL<EZE> isan S! Appli.

Main Menu p> Tools > Dictionary

1 Read sg& (disclaimer) = OK
7 —% A TOOL<EFE> activates.

P.12-2) ® To disable &

Add shortcut Create a shortcut (C%P.1-22) Uncheck 77 7 U BEEIRFIC BB IC e oo (Always show
icon disclaimer when accessing dictionaries)
Send Ir data  (C%P.10-3)
Sendalllr  (C¥P10-3) 2 (@) - Enteraword
data Search results appear.
IC (%P.10-5) ® To scroll pages: (0)/(o) 12
transmission ® To switch dictionaries: CD/(3)
AllIC (C%P.10-5) ® To search again: (/) [E#&%5] g‘
transmission Select q by
Copy to Copy a note to microSD Card 3 electawor
microSD > YES Details appear.

® To display data on microSD Card: £5P.9-18
Notepad Info  Display entry date, latest modified date and category of 4 To end, (=) = Stopped

note
Category > Select a category

® When no category applies, select None. @ While Dictionary application is active, press (&)[% = 2 —] for useful
Delete this > YES functions.
Delete > Check notes = (=)[Finish] - YES
selected
Delete all > Enter Phone Password = YES

12-9



-
N

sjoop

12-10

Sound Recorders
IVoice Recorder

Set recorded sounds for ringtones.
@ Record for about 60 seconds each.

Main Menu p> Tools > Sound Recorders > Voice Recorder
1 YES
2 (@JIStopl/&7a/(=) (= OK) to stop recording

Recorded sounds are saved in Ring Songs&Tones folder.

\H

I Voice Announce

Set recorded sound for on hold tone/holding tone, Alarm,

Calendar event alarm, Tasks alarm, ringtones, Answer Phone

message, Timer Watching (Digital TV), Ring Songs&Tones

Play List.

@ Record only one item for about 15 seconds.

® Select Voice Announce in individual window to set Voice Announce as
specific tone.

Main Menu p> Tools > Sound Recorders > Voice Announce

1 Record

Recording starts.
Tone beeps five seconds before recording ends.

2 (®)[Stop] to end recording

Tone beeps twice and previous screen returns.
® To play back: Play
® To delete: Frase = YES



Bar Code Reader
Scan barcodes (JAN) or QR Codes with built-in camera.
Access websites, send messages, etc. from QR Codes.

JAN Codes
JAN Code is a one-dimensional bar code denoting numerals with bars
and spaces of different widths.

QR Codes [w] h-:ﬁu [w]

QR Code is a two-dimensional bar code containing %
-E d

information.

I Scanning Barcodes

Up to five items can be saved.
For split data, scan up to 16 divided QR Codes.

Main Menu p> Tools b Bar Code Reader p> Scan Barcodes

1 Frame barcode in the center of Display

® To adjust Display brightness: (7)[Menu] = Brightness -
Adjust to -3 (dark) - +3 (light)

® To zoom: ()

® To use Focus Lock: (2)

\H

2 (e)[Start]

Scanning starts, and scanned results
appear when completed.

SoftBank mobile phones

@ For split data, OK = Repeat Step TBD
Tand 2
® To use scanned data: [3Step 2 on P.12-12
Example:
Scanned Results
Window

(QR Code: r>Left)
3 (¥[Menu] - Save result - OK

[ Bar Code Reader

@ 941P cannot read barcodes or two-dimensional codes other than JAN/
QR Codes.

® Some barcodes cannot be read depending on code type or size.

@ Barcode recognition may be slow. Hold handset steady while scanning.

@ Barcodes may not be correctly read owing to scratch, dirt, damage,
quality of printed material, light reflection, or QR code version.

-
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IViewing/Editing Scanned Data

Main Menu p> Tools > Bar Code Reader p> Saved Data List
1 View

Select an item

Edit Title

Highlight an item = (x7)[Menu] — Edit title - Edit
M Delete Saved Data

> In Step 1, (highlight an item =) (7)[Menu] - Delete — Delete this
or Delete all (= For Delete all, enter Phone Password) = YES

-
N
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I Using Scanned Data

Main Menu P> Tools > Bar Code Reader p> Saved Data List

1 Select an item

2 (x7)[Menu] = Select an item (See below)

Item Operation/Description
Save result  Save scanned results
Display list  Display Saved Data List
Internet Connect to URL
> Yahoo! Keitai or PC Site Browser = YES
® Alternatively, select URL to connect to Internet.
Compose Create S! Mail to selected address (%From Step 4 on
S! Mail P.13-4)
® Alternatively, select address to create S! Mail.
Dialing Call selected phone number
> Select a dialing method = Dial
® Alternatively, select phone number to dial.
Add to Save scanned results to Phone Book (C%From Step 2 on
Phone Book P.4-5)
Add Save URL to Bookmark
bookmark > YES - (@)[0K]
Copy Copy selected characters to another place (Z3From Step 2

on P.3-9)
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Basics

Send messages via S! Mail or SMS.

\H

I Available Entry Items & Character Entry Limits

Item S! Mail SMS
S Mail Exchange text messages with SoftBank or e-mail E-mail
) compatible handsets, PCs, etc.; attach image or > | address O Up to 246 single-byte B
[Separate sound files etc g |ph i g/ ’ ingle-b
subscription S . N 3 alphanumerics Up to 21 single-byte
required] ) 9;;5153 c;)mpatlble with Graphic Mail 2 E:::lbeer | O | Upto 20 recipients alphanumerics/Up to
(©FP13-5) 1 recipient
Exchange short text messages with SoftBank Up to 256 double-
SMS
handsets. . byte/
Subject O Up to 512 single- B
® For more information, visit SOFTBANK MOBILE Corp. Website .
(http:/fwww.softbank.jp) byte alphanumerics
P ) il Up to 70 double-/
Text O | 30KB single-byte
® Messaging functions are also available in Horizontal Open Position. alphanumerics ?
Switching Normal Position to Horizontal Open Position may end active Attachment O3 -
screen. ! SoftBank handset numbers only

~

w

When text entry mode is set to English (160char.) (C5P.18-19), up to
160 single-byte alphanumerics can be entered.

Up to 300 KB including subject, message text and attachment can be
sent.

® S! Mail text character limit differs by attachment size.

® When number of entered characters exceeds limit in SMS, S! Mail
conversion option message appears.

® S! Mail cannot be converted to SMS.
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I Messaging Folders & Memory Status

Messages are organized in folders by message type.

Messaging Folders

Incoming Mail

—
== a1 H-T1)L5 13
L ]

"= = = = =39 Spam Folder

Create Messages
Save as Drafts
Send Messages

Complete/Not complete ==

* Set Auto-sort to sort received messages to specified folders or Spam Folder
automatically (C%P.13-16, P.13-17).

Sent/Unsent |

Deleting Messages Automatically

When memory for messaging folders is low, old messages are
automatically deleted one by one. Protect important messages from
unintentional deletion (£%P.13-21), or set message deletion settings to
OFF (%P.18-18). Messages in Drafts and SMS on USIM Card are not
deleted automatically.

When Messaging Memory is Full

8 (Received Full) appears in Standby and no more new incoming
messages are received. Delete old messages in Incoming Mail folder
([C%P.13-21). Retrieve new messages (C%P.13-15) after deleting some
S Mail.

\H

I View Memory Status
> (&) - Memory Status

JiPeceeccccccccccccccoccccoe
@ Mail Security (C%P.11-10)

I Customizing Handset Address

Change your handset mail address (alphanumerics before @)
to reduce the risk of receiving spam. Default account name
is random alphanumerics.

Account Domain
[ Name 7 [ Name 7]

abc123-xyz @ softbank.ne.jp

|:‘ Customize here

® For details, visit SOFTBANK MOBILE Corp. Website
(http://www.softbank.jp).

® Handset mail address cannot be changed in Emission OFF Mode.

® For operations while using Internet: £%P.14-6

1 - Settings = Custom Mail Address

941P connects to the Network.
Follow onscreen instructions.

buibessapy a
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Sending S! Mail & SMS
I Sending S! Mail
Example: Select a Phone Book entry to send S! Mail.

1 Pressand hold R —

tsubl<Add Subject>
Address field - 28<Add Attachment> |
Subject field CW<Input Text> |

Attachment field
Text field TBD

Composition Window

B [<Add_Address> ]
Destination Address
g
F Senf Addnmn
ElRecei eB'*ss
EIMail Group
EAddress Input
[Phone Number Input

L} Phone Book
Ivv S oEI#®]

2 Select Address field =
Phone Book

3 Select a Phone Book entry =
Select a SoftBank handset number
or mail address

® Press (0 to toggle tabs if both mail
addresses and phone numbers are
saved.

ki Taro

OXXXXXXXX

BKeita!
iShira 3L

@ Suzuki Goro

> New S! Mail
TolAoki Taro
5 <Add Subject>

E(AdErB.nO

4 Select Subject field -
Enter subject

TCAS

5 Select Text field

6 Enter text

TBD

[~ Add Art “Preview
Text Entry Window

[ TolAoki Taro
(sublHel lo
[ 28<Add Attachment>

[@EI Message 1138ytes |
Long tlm'rB.How

are you uding:

1 am fine as usual.
By the way, can we
have lunch together
this Saturday?

7 (=)[Send]

P ececcccccccccccccoccccoe
@Addresses @Functions Available while Creating Messages (%P.13-8)
@Sending Options (C%P.13-9) @Sending Messages (%P.13-10)

(ETIFD @Confirm Message Delivery ((%P.18-18)

PR
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Adding Attachments
-
After Step 6 on P.13-4, select aoTo
Attachment field A T—

LL__._]Message 11 3Byﬁes
| Lo B D
Select a folder in Data Folder = I an fine as usual.

By the way, can we

Select a file s satordaye "
= New S! Mail
3 [Send] [ TolAoki Taro
(sublHel lo

[ 2HAttachment Nums:1
(B8 Message:113Bytes
Long timz 2oy 228 How
are you [l

I am fine as usual.
By the way, can we
have lunch together
this Saturday?

I Attach Captured Pictures/Videos

> After Step1, Activate Camera - Photo mode or Video mode -
Frame subject = (@)[Record], (0) or (@) (= For video, (@)[Stop],
() or () = (@)[Save], () or ()W

® Some files can not be attached depending on the file format or size.

® Some copy protected files can not be sent.

® Ring Songs&Tones, Music and Videos files cannot be attached directly
from microSD Card. Move files to handset before attaching to
messages.

P ecccccccccccccccccccce
@Attachments (C%P.13-8)

PR

Graphic Mail

Create HTML messages; select font color/size, background
color, or insert images, etc.

Example: Use various Templates to create Graphic Mail.

® Change font size
® Scroll text

1 After Step 4 on P.13-4, press (7)[Menu] -
Load Template — Select a template
® To view template: Highlight template = (=)[View]

D SelectText field — Delete "30(cxzzELNTR"

- Font Size

® Alternatively, (x)[Menu] -
Set Graphic Mail to open Graphic
Palette

Font| Size
ae¥%  [R29978/30720u

Graphic Palette

buibessapy a
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4 Select a font size = Enter text

5 - Select area

6 Place cursor before a sentence
to scroll = (@)[Start] = Move
cursor to end of sentence -

(eJ[End]

Set Scrolling - (x7)[Exit]

[4) to preview -
® Alternatively, (xJ)[Menu] -
Preview to view text field

9 (e) » [@send]

~
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m B Message MW E

VALY .
[~ Add Art “Preview

', [R29926/30720u1

Shall we go togf

I Reset Operations

> To cancel previous operation: Close Graphic Palette = (7)[Menu] -
Undo

> To reset all Graphic Mail operations: - Graphic all reset = YES -
YES

Using My Pictograms

1 After Step 5 on P.13-4, in text entry window,
- (@)[My Pict.]
My Pictogram list appears.

® Previously used pictogram list appears first.
@ Functions in pictogram list (C5P.3-4)

2 Selecta My Pictogram

My Pictogram is entered.
3 Enter text > (&)[Send]

I Use My Pictograms from Graphic Palette
> In text entry window, - My Pictograms — (&)[My Pict.] -+
Select a My Pictogram = (37)[Exit]

I Use My Pictograms Saved in microSD

> In text entry window, — Insert files — File Select = Pictures -
(@)[microSD] = My Pictograms — Select a folder = Select a My
Pictogram
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@Use Other Graphic Mail Settings (C%P.13-9)
@Download Templates via Internet (C%P.13-10)
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